MITSUBISHI

Integrated FA Software

CW Workbench

Operating Manual

i
e BT |
o

L xm" ‘,,.mui
s

1 anasvieust)
(1:4m

e ”cn s002)  cgpe
. zonizatt

e
g

qrw'""‘”’“ Lo e anxl N

rinerEvent ¢ ]

M'TSUBISH|

Htegfated FA S f[
Ware

. (@ serv struct S

e struct 5=
o 5 O o
- . oo 1 -l 70
° |ﬂleg 4o ommarveieione 0P tofen shortint 43 °
b 27 13:46 - sRet shortint 437" E

2 julesExeaor -
. o oD m‘wmwdﬂwﬁ argedpeett x 10/10/
(1 g usetmeves enwrceeide 9 o 3 RET =
011 Lol et 3 Hen oS SO L et 1070271 P

¥ relto o pderide arget Wm;;; :: ;:

2 ot 26t OO oy w010
Englneel’lng tool Poiereg by WIND i ;’;““:Mmmm oo 8 .
V 0 hr C c°nlrulle; mod i R]VE'R idearget 10/10/27 13: s =
0dul .

! inder Dy Senr
Cooucedtodvsere 3t
| o3 25

Engin

Al rights reserved.

Copyright Wind River Systens Inc. 2010.

Powered by CW Workbench was jointly developed by Mitsubishi and
WIND RIVER | wind River Systems, Inc.

Integrated FA Software SW1DND-CWWLQ12-E
SW1DND-CWWLQ24-E






@SAFETY PRECAUTIONS @

(Read these precautions before using this product.)

Before using this product, please read this manual and the relevant manuals carefully and pay full attention
to safety to handle the product correctly.

The precautions given in this manual are concerned with this product only. For the safety precautions of the
programmable controller system, refer to the user's manual for the CPU module used.

In this manual, the safety precautions are classified into two levels: “AWARNING" and “ACAUTION".

( )

é WARNING Indlce!tes.that incorrect hand_llpg may cause hazardous conditions,
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions,
ACAUTlON resulting in minor or moderate injury or property damage.

\_ J

Under some circumstances, failure to observe the precautions under "A CAUTION" may lead to serious

consequences.
Observe the precautions of both levels because they are important for personal and system safety.

Make sure that the end users read this manual and then keep the manual in a safe place for future
reference.

[Design Precautions]

/\WARNING

@ For the following controls, configure an interlock circuit in the user program to ensure that the entire
system will always operate safely.
(1) Changing data of the running C Controller module from the development environment (personal

computer) connected

(2) Changing the operating status
(3) Operation from the development environment (personal computer)
Especially, in the case of a control from an external device to a remote C Controller module,
immediate action cannot be taken for a problem on the C Controller module due to a communication
failure.
To prevent this, configure an interlock circuit in the user program, and determine corrective actions to
be taken between the external device and C Controller module in case of a communication failure.




[Startup and Maintenance Precautions]

/\WARNING

@ For the following controls, configure an interlock circuit in the user program to ensure that the entire
system will always operate safely.
(1) Changing data of the running C Controller module from the development environment (personal

computer) connected

(2) Changing the operating status
(3) Operation from the development environment (personal computer)
Especially, in the case of a control from an external device to a remote C Controller module,
immediate action cannot be taken for a problem on the C Controller module due to a communication
failure.
To prevent this, configure an interlock circuit in the user program, and determine corrective actions to
be taken between the external device and C Controller module in case of a communication failure.

[Startup and Maintenance Precautions]

/\CAUTION

@ Before performing online operations (especially, program modification, forced output, and operation
status change) for the running C Controller module from the peripheral connected, read relevant
manuals carefully and ensure the safety.

Improper operation may damage machines or cause accidents.




@CONDITIONS OF USE FOR THE PRODUCT@®

(1) Mitsubishi C Controller system ("the PRODUCT") shall be used in conditions;
i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major
or serious accident; and
ii) where the backup and fail-safe function are systematically or automatically provided outside of
the PRODUCT for the case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general
industries.

MITSUBISHI SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT

LIMITED TO ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT,

WARRANTY, TORT, PRODUCT LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR

LOSS OR DAMAGE TO PROPERTY CAUSED BY the PRODUCT THAT ARE OPERATED OR

USED IN APPLICATION NOT INTENDED OR EXCLUDED BY INSTRUCTIONS, PRECAUTIONS,

OR WARNING CONTAINED IN MITSUBISHI'S USER, INSTRUCTION AND/OR SAFETY

MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT.

("Prohibited Application")

Prohibited Applications include, but not limited to, the use of the PRODUCT in;

* Nuclear Power Plants and any other power plants operated by Power companies, and/or any
other cases in which the public could be affected if any problem or fault occurs in the PRODUCT.

« Railway companies or Public service purposes, and/or any other cases in which establishment of
a special quality assurance system is required by the Purchaser or End User.

« Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as
Elevator and Escalator, Incineration and Fuel devices, Vehicles, Manned transportation,
Equipment for Recreation and Amusement, and Safety devices, handling of Nuclear or
Hazardous Materials or Chemicals, Mining and Drilling, and/or other applications where there is a
significant risk of injury to the public or property.

Notwithstanding the above, restrictions Mitsubishi may in its sole discretion, authorize use of the
PRODUCT in one or more of the Prohibited Applications, provided that the usage of the PRODUCT
is limited only for the specific applications agreed to by Mitsubishi and provided further that no
special quality assurance or fail-safe, redundant or other safety features which exceed the general
specifications of the PRODUCTSs are required. For details, please contact the Mitsubishi
representative in your region.



INTRODUCTION

Thank you for purchasing CW Workbench.
This manual explains about the product.

Before using this product, please read this manual and the relevant manuals carefully and develop familiarity with the
functions and performance of CW Workbench and applicable modules to handle the product correctly.



RELEVANT MANUALS

The manuals related to the product are listed below.

Please place an order as needed.

Manual
<Manual No. and model code>

Description

C Controller Module User's Manual
(Hardware Design, Function Explanation)
<SH-080766ENG, 13JY80>

The manual describes system configuration, specifications, functions,
handling methods, wiring and troubleshooting of the C Controller
module.

C Controller Module User's Manual
(Utility Operation, Programming)
<SH-080767ENG, 13JY81>

The manual describes installation/uninstallation of SW3PVC-CCPU,
utility operations, and functions and programming.

C Controller Module User's Manual (Q24DHCCPU-V)
<SH-081130ENG, 13JZ75>

The manual describes system configuration, specifications, functions,
handling methods, wiring, troubleshooting, and programming and
function of the Q24DHCCPU-V C Controller module.

Setting/Monitoring Tools for the C Controller Module
Operating Manual
<SH-081131ENG, 13JU76>

The manual describes the operations of SW4PVC-CCPU.

Wind River Workbench 3.2 manuals

The manuals describe specifications, usage methods, troubleshooting,
and relevant documents of Wind River Workbench 3.2 that is the base
for this product.

Refer to the manuals for the same functions as Wind River Workbench.
A PDF file of the manuals is stored on the DVD-ROM disc of the product.
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MANUAL PAGE ORGANIZATION

The following illustration is for explanation purpose only, and should not be referred to as an actual documentation.

_Indicates the chapter of

I CHAPTER 8 CREATING AND BUILDING USER PROGRAM
currently open page.

3. select "C-Compiler" for “Build tool:".

Click the Tool Flaes.. button.

indicates
the useful tip.

4. onthe "Optimization" dialog box, select [Enable
maximum speed optimizations]. Check that *-02"
has been added to "Selected option:" and click the

0k button.

Indicates the section
of currently open page.

uondo uoeziwdo Bulss b8

o=
N Point findicates
Point? ;
1 the particular
To cancel the optimization option, dlick &7 | in "Enable Optimization" on "Optimization" and change the mark to .
& (cancel). Check that "-O* has been deleted from "Selected option™" j attention.

<

To the next page
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Operating procedures
Three styles of descriptions are used in this manual as below:

(1) When there is only one operation

O Menu bar [Help] 2> [Help Contents]

(2) When there are steps

1. Copy the created source file to the current folder of a project to be added.

2. Select the project to be added on the "Project Explorer” window.

(3) When there are multiple operations

« Enter a folder name of the installation location and click the Ok button.

» A folder can be selected by clicking the  Brows=.. | button.



Symbols used in this manual

The following shows the symbols used in this manual with descriptions and examples.

& Basic Device Development — UserProject/Sample.c - CW Workbench

File Edit Source Refactor Mavigate Search BEGIESSCmm—itfindo Help
@—» i [ - Al F RN _
Praject References
[ Project Explorer 52 =R R Glage Praject

A Do,

-l Bwld Targets (SHTTE0znu =)

s Wind River Launches awb Build &l
3 Binaries Build Fraject
il Ineludes Clean..
(= SH77EDerulz

@ Samplec Build Optionz

Open Wind River Wiworks 64 Development Shell

% Properties for UserProject

boefieen ] buid properties -
Re:
BlnSaDr:rT’erer Specify all build properties.
es @ Build Support and Specs | &F Bujld Tooks $—Brrild- Beritd-Pathe—— =t
Biliers L @
@ -+ (/C+ General Petild toak |O—Oomp|\er v‘ [ [ ] [Rename..] [ Capy.. ] [ Delete.. ]
Praject Info
Project References
Refactoring History Suffizes: %o ]
Fun/Debug Settings ’ )
Task Tags Build output gencration
Validation (®) Generated build output iz an object
(O Generated build output iz & build tarest
Build spec specific settines
Active build spec: [sH77508nule v
Derived sutfix: [*o |
Gommand # |echa "building 38" ¥ccompilerprefix® $TOOL PATHIcosh % ~
DebughodeF laes ¥ToolF laesk SADDED_ GFLAGS) Sncludssd 3
$ADDED INCGLUDES) -DCPU=§ICPUY - =
DTOOL_FAMILY=3TOOL_F AMILY) ~DTOOL=5(TOOL) -DWRS KERNEL '~
Tool Flags. & |$CC_ARCH SPECY —ansi -Wall -MD -MP
Debug mode flaes
Debug mode 7 E |
Mon Debue mode..| & |02 —fno-buiktin ]
@ o=t ®
No. Symbol Description Example
O] [ ] Menu name on a menu bar [Project]
©) i Toolbar icon il
® " Screen name or item name on a screen "Build tool:"
@ << > Tab name on a screen <<Build Tools>>
® Button on a screen oK |

Keyboard key

Reference page

- [ ]

Reference manual
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GENERIC TERMS AND ABBREVIATIONS

Unless otherwise specified, this manual uses the following generic terms and abbreviations.

Generic term/abbreviation

Description

C Controller module

Q24DHCCPU-V

The abbreviation for Q24DHCCPU-V C Controller module

In principle, 'C Controller module' indicates Q24DHCCPU-V C Controller module. When

the classification is needed for such as comparison with other C Controller modules,
'Q24DHCCPU-V' is mentioned.

Q12DCCPU-V

The abbreviation for Q12DCCPU-V C Controller module.

C controller setting and
monitoring tool

The generic term for C controller setting and monitoring tools shown below.
* Q12DCCPU-V
SW3PVC-CCPU
* Q24DHCCPU-V
SW4PVC-CCPU

VxWorks The real-time operating system manufactured by Wind River Systems, Inc.
The generic term for the engineering tools for C Controller shown below.
* Q12DCCPU-V
CW Workbench SW1DND-CWWLQ12-E, SW1DND-CWWLQ12-EZ, SW1DND-CWWLQ12-EVZ

* Q24DHCCPU-V
SW1DND-CWWLQ24-E, SW1DND-CWWLQ24-EZ, SW1DND-CWWLQ24-EVZ

Wind River Workbench

The generic term for Wind River Workbench manufactured by Wind River Systems, Inc.

Personal computer

. . ®
The generic term for personal computers where Windows operates

11



TERMS
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Unless otherwise specified, this manual uses the following terms.

Term

Description

Dedicated function library

The generic term for bus interface function, MELSEC data link function, and C Controller
module-dedicated function.

Bus interface function

Dedicated function library offered by C Controller module.

This function is used when executing the following:

* Input from or output to I/O modules controlled by the C Controller module
» Access to the buffer memory of an intelligent function module

* The readout or control of the C Controller module status

MELSEC data link function

Dedicated function library offered by C Controller module.
This function is used when writing to/reading from a device of other programmable
Controller CPUs connected via network or configured with multiple CPUs.

C Controller module-
dedicated function

Dedicated function library that controls C Controller module.
This function is used when reading the C Controller module status, controlling LED, and
accessing to resources such as time and battery backup RAM.

The abbreviation for Uniform Resource Locator.

URL This address indicates a location of information resources (such as text and images) on the
Internet.
Eclipse An open source software development environment comprising an integrated development

environment written in Java




CHAPTER 1 OVERVIEW

CHAPTER 1 ovERVIEW

CW Workbench is a product for customers who develop a user program that operates on the C Controller module.
CW Workbench is an OEM product of Wind River Systems, Inc. The product has only basic functions required for user
program development, such as coding, building, and debugging, as a subset product of Wind River Workbench 3.2.

1 .1 Features

Engineering tool for C Controller, CW Workbench, is software to offer dedicated integrated development environment
for the Mitsubishi C Controller module.
CW Workbench has the following features:

(1) Software to offer dedicated integrated development environment for the C

Controller module
This product is an integrated development environment to execute the following operations: project management,
source code editing, building, and debugging. A user program for the C Controller module can be effectively

developed.

(2) The same specifications as those of Wind River Workbench 3.2
Displays and operations of CW Workbench are the same specifications as those of Wind River Workbench 3.2 for

common functions.

(3) The operating system of the development environment (personal computer) is
compatible with Windows® 7.

sainesq ||

The operating system of the development environment (personal computer) is compatible with Windows® XP,

Windows Vista®, and Windows® 7.

(4) Extended functions using plug-in software
The third party plug-in software can be easily added, which allows functions to be easily extended.

13



CHAPTER 2 sYSTEM CONFIGURATION

2.1 Environment Configuration for Each License Type

This section explains the environment for developing user programs in CW Workbench.
A permanent license is required to install CW Workbench. ([__3 Page 22, Section 5.1)

(1) Product with license

C Controller module

=" Permanent ] Permanent

=1 . Xfil .

= | license <:| 1 | License

— file Application Form

CW Workbench
CW Workbench (SW1DND-CWWLQ12-E,
User program creating and building SW1DND-CWWLQ24-E)

(2) Additional license product

277 Permanent Permanent
’VE license <:| Lglj License
= file —! Application Form
C Controller module e ~
‘ § CW Workbench
— (SW1DND-CWWLQ12-EZ) *
Tyt s - J
E 4 N
>y | 1|2 CW Workbench
L (SW1DND-CWWLQ24-EZ)*
g J
4—

(O

CW Workbench
CW Workbench (SW1DND-CWWLQ12-E,

User program creating and building ~ \_ SW1DND-CWWLQ24-E)

*1 The DVD-ROM is not included with the CW Workbench additional license product (SW1DND-CWWLQ12-EZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license (SW1DND-CWWLQ12-

E) is required.
*2 The DVD-ROM is not included with the CW Workbench additional license product (SW1DND-CWWLQ24-EZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license (SW1DND-CWWLQ24-

E) is required.

14



CHAPTER 2 SYSTEM CONFIGURATION

(3) Updated license product

C Controller module C Controller module
(Q12DCCPU-V)*2 (Q24DHCCPU-V)

User program debugging User program debugging
(SW1DND-CWWLQ12-E) (SW1DND-CWWLQ24-E)

27| Permanent 5] Permanent
== | license - | License

— file — Application Form

[ CW Workbench j ﬁ
)*1

I8

\

\u

(SW1DND-CWWLQ24-EVZ

o

CW Workbench

CW Workbench = = (SW1DND-CWWLQ12-E)
User program creating and building

(SW1DND-CWWLQ12-E *24 SWA1 DND-CWWLQ24-E)

*1 The DVD-ROM is not included with the CW Workbench updated license product (SW1DND-CWWLQ24-EVZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license
(SW1DND-CWWLQ12-E) is required.

*2 The configuration before installing the updated license product (SW1DND-CWWLQ24-EVZ) is indicated.

Point/’

If the CPUs to be used after update are not written in "Target CPU" of Permanent License Application Form, please consult
your local Mitsubishi representative.

adA] asusoi yoeg Joj uonenBiuos JUSWUOIIAUT |2
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2.2 Relevant Module

CW Workbench is compatible with the following C Controller module:

Model Operating System Relevant software package
SW1DND-CWWLQ12-E
Q12DCCPU-V VxWorks 6.4 SW1DND-CWWLQ12-EZ

SW1DND-CWWLQ12-EVZ

SW1DND-CWWLQ24-E
Q24DHCCPU-V VxWorks 6.8 SW1DND-CWWLQ24-EZ
SW1DND-CWWLQ24-EVZ

2.3 Operating Environment

Below is a list of the operating environment of a personal computer where CW Workbench can be operated.

Item Description
PC/AT-compatible personal computer in which the following operating systems can be
Computer
operated.
CPU Intel*Core™2 Duo 2GHz or higher is recommended.

Memory requirements | 1G byte or more (2G bytes or more is recommended)

Install size: HDD 4G bytes or more

Hard disk space
P Executable size: Virtual memory 512MB or more

Display 1024-by-768 resolution or higher
Disk drive DVD-ROM drive
Interface Ethernet 10BASE-T/100BASE-TX/1000BASE-T

- Microsoft® Windows® 7 Professional (Japanese/English)™

« Microsoft” Windows® 7 Ultimate (Japanese/Eninsh)*5

« Microsoft” Windows® 7 Enterprise (Japanese/English)®

08 12734 « Microsoft” Windows Vista" Business (Japanese/English) Operating System
- Microsoft® Windows Vista® Ultimate (Japanese/English) Operating System
- Microsoft” Windows Vista® Enterprise (Japanese/English)

« Microsoft” Windows® XP Professional (Japanese/English) Operating System Service
Pack3 or later

*1 A 64-bit operating system is not supported.
*2 The following functions cannot be used.
Using the following functions may lead to improper operation of CW Workbench.

* Application execution in Windows® Compatibility Mode

* Fast User Switching

* Remote Desktop

« Large fonts (detailed setting in the screen properties)

* DPI setting other than 100%
*3 Log on as a user with the Administrator attribute when installing and uninstalling CW Workbench.
*4 TCP/IP is required.
*5 The following function cannot be used:

« Windows® XP Mode

16



CHAPTER 2 SYSTEM CONFIGURATION

2.4

Below are specifications of CW Workbench.

Specifications

Item

Specifications

Product name

CW Workbench

Operating system of applicable host
machine

Refer to "Operating environment"(_= Page 16, Section 2.3)

Applicable C Controller module

Refer to "Relevant Module".((__3 Page 16, Section 2.2)

Applicable operating system

Q12DCCPU-V VxWorks 6.4

Q24DHCCPU-V VxWorks 6.8

Framework

Wind River Workbench 3.2 base (Eclipse3.5)

Project creation and management

VxWorks Downloadable Kernel Module Project

Building

Q12DCCPU-V GNU compiler (GCC 3.4.4 for SH-4A)

Q24DHCCPU-V GNU compiler (GCC 4.1.2 for Intel Atom Z5xx)

Debugger

» Debugging execution restart

» Debugging execution forced stop

* Breakpoints

« Step through execution

* Variables/structure variables reference and editing
* Register value reference and editing

» Memory block reference and editing

« Target connection agent

* Dynamic Printf (Q24DHCCPU-V only)

License format

Node locked

Document

Wind River Workbench 3.2 Help document

17
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CHAPTER 3 PACKING LIST

3.1

Packing List

The following items are included with CW Workbench. Check that all the items are included before use.

(1) Items included with CW Workbench

Model name Item Qty.
DVD-ROM([_ = Page 18, Section 3.1 (2)) 1
"Before Using the Product” 1
(Product with license)
SW1DND-CWWLQ12-E License Certificate 1
SW1DND-CWWLQ24-E
End-User Software License Agreement 1

Permanent License Application Form (sample)

(Additional license product )
SW1DND-CWWLQ12-EZ
SW1DND-CWWLQ24-EZ
(Updated license product ')
SW1DND-CWWLQ12-EVZ
SW1DND-CWWLQ24-EVZ

"Before Using the Product”

License Certificate

End-User Software License Agreement

Permanent License Application Form (sample)

*1 The DVD-ROM is not included with the CW Workbench additional license product or updated license product. To install
CW Workbench, the DVD-ROM included with the CW Workbench product with license is required.

(2) Contents of CW Workbench DVD-ROM

Content Description Storage location
\
CW Workbench install image | An install image file of CW Workbench )
\images
Relevant manuals of VxWorks and Wind River Workbench 3.2 \docs

Relevant document

(PDF)

A license notice (PDF) of the third party used in CW Workbench

\3rd_party_licensor_notices

Manual CW Workbench Operating Manual (PDF) \manual
An application form for a permanent license and a license transfer.
Permanent License (PermanentLicenseApplicationForm.xls) \
Application Form Use the form when applying for a permanent license and a license
transfer.
A file to be used as an install key when you do not have a
. permanent license file and do not have the Internet.
Install key file ) . . \
CW Workbench operates with no license when having been
installed using an install key file (Install_SH_IA.txt).
CW Workbench )
A CW Workbench open source file \src

open source file

18



CHAPTER 3 PACKING LIST

3.2 Things to Prepare

The following lists things to prepare before using CW Workbench.

(1) Development environment (personal computer)

Prepare a personal computer to install and use CW Workbench.

Point/’

Enter the host name within 2 to 15 alphanumeric characters for a personal computer to be used as a development
environment (personal computer).
Operating Environment for operating specifications of a personal computer.([__ = Page 16, Section 2.3)

(2) CW Workbench DVD-ROM
Prepare a CW Workbench DVD-ROM included with the product with license (SW1DND-CWWLQ12-E,

SW1DND-CWWLQ24-E).
The DVD-ROM is required to install CW Workbench. Apply for a permanent license using an application form

stored on the DVD-ROM.

(3) License Agreement
An LAC described in the License Agreement is required to install CW Workbench by using a temporary license.
An LAC and a product ID described in the License Agreement are also required to apply for a permanent license.
Prepare the License Agreement included with CW Workbench.

(4) Permanent license file
A permanent license file is required to install CW Workbench by using a permanent license.
To acquire a permanent license file, use a Permanent License Application Form stored on the DVD-ROM and

send us the Form.

aledaid 0y sbuiyl z'¢

(5) Internet connection
An Internet connection is required to install CW Workbench by using a permanent license.
Acquire a 31-day temporary license via the Internet.

19



CHAPTER 4 PROCEDURE OVERVIEW

4.1 From Installation to Debugging

Obtain a permanent license.
Apply for a permanent license.

[ > Page 22, Section 5.1

Installation
How do you install the product?

Use the permanent license file for Use the temporary license file for Use the install key file for
installation installation. installation.
Internet Connection: Yes Internet Connection: No
[ 5 Page 20, Section 4.1 (1) [ 5 Page 20, Section 4.1 (2) [ 5 Page 20, Section 4.1 (3)
A J A J o

[ 5 Page 27, Section 6.1

SO == e — — ,

Apply a permanent license.
Apply a permanent license that is sent later to the development
environment (personal computer).

[ Page 25, Section 5.3

)
,
,
| Permanent License File: Yes Permanent License File: No Permanent License File: No
,
,
,
,
,
i
i

v
To the next page

(1) Installation using a permanent license

This installation is for users with a permanent license (regular license). All the functions of CW Workbench can be
used for unlimited duration.

(2) Installation using a temporary license

This installation is for users with a temporary license acquired on the Internet. All the functions of CW Workbench
can be used for 31 days after the installation.

(3) Installation using an install key on the DVD-ROM

This installation is for users having neither permanent license nor Internet connection.
Only the editor, import, and export functions of CW Workbench can be used. The build, compile, or debug
functions cannot be used.
Note that for SW1DND-CWWLQ24-EVZ, the installation using the following install key files cannot be executed.
* Install_SH4.txt of SW1DND-CWWLQ12-E
* Install_SH_IA.txt of SW1DND-CWWLQ24-E
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CHAPTER 4 PROCEDURE OVERVIEW

FLEXIm License Finder 3]

our application was not able ta obtain a license

The dialog box shown to the right appears when
CW Workbench is started up with no license. £ o ATl et

needs. Please choose one of the following

Click Cancel to continue the operation. ey —

) Specify the License File

Copyright [c) 1933, 2003 Macravision Corporation

From the previous page

!

Apply a patch.

Information and services
For further information and services, please consult your local Mitsubishi representative.

[~ 5 Page 52, CHAPTER 7

Create a project.
Create a user program project and perform programming.

[ 5 Page 55, CHAPTER 8

Build.
Build a user program.

[ 5 Page 69, Section 8.3

Connect the target.
Connect CW Workbench to the C Controller module.

5 Page 75, CHAPTER 9 )

Download.
Download the user program on the C Controller module.

Buibbngaq 0} uone|elsu| woi4 'y

[ 5 Page 83, CHAPTER 10

Debug.
Debug the user program.

[ 5 Page 83, CHAPTER 10
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CHAPTER 5 PERMANENT LICENSE

5.1 Obtaining Permanent License

A permanent license is required to use CW Workbench for unlimited duration. Follow the instructions shown below to
obtain a permanent license.

Start obtaining a permanent license.

!

Obtain a Permanent License Application
Form on the DVD-ROM.

!

4 7\

Obtain host information on the development = Refer to thg Permanent License Applicatign Form (sam_ple)
environment (personal computer) where !ncluded_ with the product for how to acquire host machine
CW Workbench is used. information.
o /.
4 N\
] ) o [ Refer to the Permanent License Application Form (sample)
Fill out the Permanent License Application included with the product for how to fill out the form.
Form. Directly enter information on the Application Form stored on
L ) the DVD-ROM (PermanentLicenseApplicationForm.xls on
l the Permanent License Application Form).
4 N\
Y
Send the Application Form to the address | lgl >
i . Il B
described on the form MAIL lj .
Permanent License —
\_ / Application Form Will be
E replied
4 N\ within
5 working
A permanent license file will be e-mailed Permanent [“#¥% days
to you. et MAIL license file ’V:E
\ )= ==
4 N\
Apply the permanent license file to the [ 5 Page 25, Section 5.3
development environment (personal ’
computer).
o .
Completed.

*1 For the development environment (personal computer) information on the Permanent License Application Form for the
updated license product, enter the same information as the one registered to acquire the permanent license previously.
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CHAPTER 5 PERMANENT LICENSE

5.2 License Transfer

Another permanent license is required on a new development environment (personal computer) for license transfer
due to reasons such as when the development environment (personal computer) where CW Workbench has been

installed crashed.
Follow the instructions shown below for license transfer.

Start license transfer.

Has the
development environment
(personal computer)
crashed?

No

Yes .
Uninstall CW Workbench on the current [ Page 39, Section 6.2

development environment (personal
computer).

A

[ = Page 26, Section 5.4

Delete the current permanent license
file.

(Delete the permanent license file
saved as a backup file as well.)

l

Obtain a License Transfer Certification
Agreement Form on the DVD-ROM.

l

Obtain host information on the development For how to obtain host information, refer to

environment (personal computer) where . L
CW Workbench is used. EZ:nI:;reTanent License Application Form

|

To the next page

Jajsuel| asusoI] Z'
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24

From the previous page

}

] ) o [z Directly enter information on the License Transfer
Fill out the License Transfer Certification Certification Agreement Form stored on the DVD-ROM
Agreement Form. (PermanentLicenseApplicationForm.xIs on the License
Transfer Certification Agreement Form).
Fax the License Transfer Certification FAX @
Agreement Form with your signature to
your local Mitsubishi service center or
representative where you purchased
the product. License Transfer
Certification Agreement Will be
! replied
H within
; 5 working
™\ Permanent [£% days
] ] ) ) irrs MAIL license file | =
A permanent license file will be e-mailed E =
to you. = | =
) =
~
Install CW Workbench on the new [ Page 27, Section 6.1
development environment (personal
computer) using the new permanent
license.
/

:

Completed

If you have lost the License Agreement and do no know the Product ID, contact your local Mitsubishi service center or
representative and give them information filled out on the Permanent License Application Form.

» Name of the representative person, department name, and company name

» E-mail address

« Target CPU



CHAPTER 5 PERMANENT LICENSE

5.3 Applying Permanent License

Another permanent license file is required on a new development environment (personal computer) when the
development environment (personal computer) where CW Workbench currently operates has crashed or when a
license needs to be transferred. Follow the instructions shown below for license transfer.

Start applying a permanent license.

Yes

CW Workbench is running.

No
Terminate CW Workbench.
v
[ = Below is a license folder when CW Workbench is installed
on the C drive without changing the folder of the installation
Copy the obtained permanent license file location.
on the license folder of CW Workbench.™ C:\WindRiver\license

= | WindRiver
) vind F_q-.f.

+ | ) docs

N =
—1] '_gnu License file

% ) e
'} |icenze

Note: Do not store the license file in folders other than the one
Start CW Workbench. specified above and use the file when applying the license
file to the development environment (personal computer).

Completed

9suaoIT Jusuewlad BuiA|ddy ¢'g

*1 When two or more permanent license files are obtained with the updated license product, overwrite all files.
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5.4

Deleting Permanent License

Follow the instructions shown below to delete the current permanent license for license transfer.

26

Start deleting the permanent license.

CW Workbench is running.

No

Terminate CW Workbench.

A

Completely delete the permanent license
file from the license folder of CW
Workbench.

(Delete the permanent license file saved
as a backup file as well.)

v

Completed

[ 5 Delete all the files in the license folder of CW Workbench.
C:\WindRiver\license

=) WindRiver
I wind _’.EJ'
'j docs Recycle bin
= P
u:I jre f_____._JLicense file



CHAPTER 6 INSTALLATION AND UNINSTALLATION

CHAPTER 6 INSTALLATION AND
UNINSTALLATION

6.1 Installation

This section explains how to install the product, how to operate, and precautions.
Unless operations differ depending on the operating system, windows and dialog boxes of Windows® XP are used for

explanations.

6.1.1 Preparation before installation

(1) Log on as a user with the Administrator attribute when installing the product
on the development environment (personal computer).

(2) Insert the DVD-ROM into the development environment (personal computer),
the installer automatically starts.

If the installer does not automatically start, double-click "setup.exe" on the DVD-ROM to start it.
Do not execute more than one "setup.exe" at the same time, or the product may not be properly installed. If the
installation was not completed properly, uninstall the product and execute "setup.exe" again.

(3) For installation on Windows Vista® or Windows* 7, a dialog box asking whether
to enable or disable User Account Control appears.

Click "Allow" or "Yes" to continue the installation.

+ For Windows Vista®

User Account Cantral =)

L identi
_\!/, An unidentified program wants access to your computer

Don't run the program unless you know where it's from or you've used it
before.

i Il setup.exe

L Unidentified Publisher
+ Cancel Click "Allow".
I'don't know where this program is from or what it's for.

% Allow
H Itrust this program. I know where it's from or I've used it before.

v Details

User Account Control helps stop unauthorized changes to your computer.

27
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« For Windows® 7

%] User Account Contral (3e)

=

@ Do you want to allow the following program from an
/" unknown publisher to make changes to this computer?

Program name:  setup.exe

Publisher: Unknown Click the button.
File origin: CD/DVD drive
(~) Show details Yes

Change when these notifications appear

(4) Acquire a permanent license file.

If you require the Permanent License Application Form, or if you have purchased the updated license
product, please consult your local Mitsubishi representative.

Point/’

@ Stop all other applications running on Windows® before installation.

® The installer may not operate the functions properly due to the automatic start of update programs of the operating

system or any other software, such as Windows® Update or Java Update. Change the setting to disable the automatic
start of update programs before installation.

@® CW Workbench cannot be over-installed on the development environment (personal computer) where CW Workbench
has been already installed. Uninstall the product before reinstallation.

® Do not install the product on the development environment (personal computer) where Wind River Workbench has been
already installed. To install the product, uninstall Wind River Workbench or prepare another development environment
(personal computer).

@® When the product is installed by using a temporary license, the product operates for 31 days. A regular license is issued
after a permanent license is obtained. Use the permanent license to start the product.

& License Nok Found & The license error message shown below appears after 31
@ Launching the tind Fiver Debug Server (DFU? Backend faild to obain the days. The product continues to operate by clicking the
Feature has expired . . .
o  Wmen Cancel button, but the project creation, compiling/
License path

A license file path is deserived building, and debug functions cannot be used.
FLEXIm error: -10,32
B e e il B o e [License error message]
Error text: "Feature has expired
Error code: -10

@ To install CW Workbench using a temporary license, it can be obtained via the Internet. Before installation, check that the
personal computer can be connected to the Internet.
If the personal computer is connected to the Internet via a proxy server, check the IP address and port number in
advance. They are required to be set during installation.

@® Note the following when installing the updated license product.
 Enter the LAC (License Authorization Code) written on the License Agreement of updated license product to LAC
on the User Information window.
» The updated license product (SW1DND-CWWLQ24-EVZ) cannot be installed with the install key file
(Install_SH4.txt) of the product with license (SW1DND-CWWLQ12-E).




CHAPTER 6 INSTALLATION AND UNINSTALLATION

6.1.2  How to install CW Workbench

Start installing CW Workbench Insert the CW Workbench DVD-ROM into the DVD drive
to start the installer.

1. Atter the installer is started, execute one of the

following operations and click the ak. |
button:

Bowse... | » Enter a folder name of the installation
location.

0k Cancel
Q I e Click the  Browse.. | button to select a

folder of the installation location from the
tree view.

& Wind River Installer

Select the Wind River install location:

Point/’

® The following characters can be used for a folder name of the installation location: (Space cannot be used.)
* Alphanumeric characters
* Hyphen "-"
» Underscore "’
The product cannot be properly installed if characters other than those described above are used for a folder name.

® The dialog box shown below may appear after the 0k | button is clicked. Clicking the Cancel |

button does not cancel the operation.

& Wind River Installer

Freparing installer

[ ] ]

uopejejsu| L9

mEm] 2. Click the Mext > button.

‘WIND RIVER

UOUSGHIOM MO (IEISUI 0} MOH 2179

<

To the next page
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® Istaller-On-line Update Settines

Ghoose on-line update settings:
[“]Check an-line for latest updates for this installer
[Z]Check on-line for latest Wind River product updates

URL for update repositeries
[httpes;

.com/oemy)

[ Gonnect to internet using proxy server

Help < Back Hext > Gancel

3. Click the [

Mext > ] button.

Point/

If the personal computer is connected to the Internet via a proxy server, check the box of "Connect to internet using proxy
server" and configure the proxy server setting set for the Internet connection on the personal computer.

8 nstaller-On-line Update Settines

Choose on-line update settings:
[Z] Check on-line for latest updates for this installer
[Z]Chesk online for latest Wind River produet updates.
URL for update repositeries

st et e oy sever

hacse provy server type:
Oieb Proxy  OSOGKS Proxy.

Part

(o J[ <ok J[ o> J[ Gueel ]

ense Aereement

By selecting "1 AGSEPT the terms of this license sereement” and clickine Next, you consent to the
terms of this agresment. If you do not wish to be bound by the terms of this sgresment. click Ganeel and
da not install this software.

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE WIND RIVER
PROPERTY AND PROTECTED BY UNITED STATES COPYRIGHT LAW AND
INTERNATIONAL ~ TREATY.  UNAUTHORIZED USE, REPRODUCTION OR
DISTRIBUTION IS SUBJECT TO CIVIL AND CRIMINAL PENALTIES.

BY CLICKING ON THE "I ACCEPT" BUTTON YOU ACKNOWLEDGE THAT YOU

HAVE ENTERED INTO AN AGREEMENT WITH MITSUBISHI ELECTRIC
CORPORATION RELATED TO YOUR USE OF THIS PRODUCT.

04April2010

(@1 AGGEPT the terms of this license agreement.
O1DO NOT AGGEPT the terms of this license agreement.

Hep ] < Back Next > Gancel

<

To the next page

30

4. Select "I ACCEPT the terms of this license

agreement.” and click the [ MNext #

] button.




CHAPTER 6 INSTALLATION AND UNINSTALLATION

5. To continue the installation, select one of the following procedures:

If the permanent license file is not obtained
« Installation using a temporary license (a personal computer can be connected to the Internet):
2> (1)(2)(3) [ 7 Page 32
* Installation using an install key on the DVD-ROM (a personal computer cannot be connected to the Internet):
2> (4)[_ 7 Page 34
If the permanent license file is obtained
« Installation using a permanent license

=> (5)[_5 Page 35

uopejeisu] L'9
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Installation using a temporary license

® Installer—Ghoose Activation Type

GChoose Tnstall Key Type:

O Use the existing product activation file.

© Permanent install key file
Entter the full path 1o your install key file

@ Temporary install key Gequires an Intemet connection)

© Manually enter all install keys

Gliek next to enter the install keys for each produist

[ ke

(1) Select "Temporary install key (requires an Internet

connection)” and clickthe [ Mext > | button.

Point/’

@ If "Temporary install key" is selected, the Internet is required to acquire "Temporary install key". Execute the installation

on a personal computer connected to the Internet.

@ If the personal computer is connected to the Internet via a proxy server, configure the proxy server setting. ((__5 _ Page

30 Point)

If "Temporary install key" is selected without configuring the proxy server setting, installation does not proceed.

® Installer-Host Information

Host Name: s

Please choose a host ID ta identify the computer an which you are installing this software.

Selection | Host ID
[9] [
o DISK_SERTAL NUM=eissas

Note: host IDs are a way to uniguely identify computers. If your computer has multiple ne
for example, wired and wireless), select your hard disk serial number as your host ID inste:

[ ke

<~

& Installer-User Information

Pleass enter your contast information and Lisense Authorization Gode {LAG.
Note: Required fields are marked iith an asterisk 0.

*LAG: [

RT—

| *Company:  [Mitsubishi Electric Corporation

*AddressT: [1-14, Yada-minami 5-chome, Higashi-ku

Address2 |

*0ity: [Nagoya

*State: [ichi

*Country: [Japan

*Zip Code: [461-8670
*E-mait [

*Phane: [+81-62-712-2278

[ ke

32

(2) Check the content of "Note" on the window. Select

either "Ethernet Adapter" or "Disk Serial Number" for

the Host ID and click the | Next > | button.

(3) Enter a License Authorization Code (LAC) and user

information listed below and click the

[ Mext » ] button.
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Point/

Use alphanumeric characters for the LAC and user information.
(Items with a * mark on the window must be entered correctly.)

LAC: License Authorization Code
(described in the License Agreement included with CW Workbench)

User Name: User name

Company: Company name

Address1: Address (such as town name and block number)

Address2: Building name, etc. (can be left blank)

City: City

State: State

Country: Country

Zip Code: Zip code

E-mail: E-mail address

Phone: Phone number

284

Go to the step 6 ([_ 5 Page 36)

1’9

uone|elsu|
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Installation using an install key on the DVD-ROM

(4) Select "Permanent install key file", click the

button, specify the following install key file stored on the

Ghoose Tnstall Key Type:

© Use the existing product activation file DVD_ROM’ and CIICk the [ ﬂexi: } ] bUtton'

O Temporary install key frequires an Intemet connection)

=> For Q12DCCPU-V: "Install_SH4.txt"
e > For Q24DHCCPU-V: "Install_SH_IA.txt"

all key file
ath 10 your install key file

Glick next ta enter the install keys far each produet

Point/

When the installation is executed with specifying the install key file, CW Workbench is installed without license and only the
following functions can be used:

+ Editor function (such as creation, editing, saving, and searching)

* Import/Export
To use all the functions of CW Workbench, obtain and apply a permanent license.
[ Z Page 22, Section 5.1

[ Z Page 25, Section 5.3

A5

Go to the step 6 ((_5 Page 36)
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Installation using a permanent license

(5) Select "Permanent install key file" and click the

WIND RIVER button.

Select the permanent license of the product to be
e installed from the tree view. Then click the

® Installer-Choose Activation Type

© Temparary install key (requires an Internet connection)

[ Mext > ] button.

28

Go to the step 6 ([_5 Page 36)

uopejejsu| L9
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® Installer—Choose Installation Filters

Target Architectures:

Elect trie o more tareet
re.wncertain. vow may. selest all af them,

Cintel Select all
CswerH | Gosaetan

6 procesEers you plan 18 e 6 vour tareet H o

[ dee J[ <Bak [ MWet> [ Camcel |

® Installer—Select and Install Products

Products and Features
B[] 9] Wind River Workberch 32 for Mitsubishi G Gortrollers

Installation Directory
C¥¥indRiver

Disk Space Information
Total Disk Space Required
Disk Space Available

127 GB
2817 GB

Help < Back Trctall Gancel

® Installer-Select and Install Products

Products and Features
& ¥l Wind Fiver Warkbench 32 far Mitsubichi C Controllers
G G Vidiorks 8.4 Application Developer
- % Wind River GNLU Gompiler 344 for VidWorks 64 (modified for Windows Vista and Windows 7
&4 Wind River Setup 201
- Wind River Warkbench 32 far WedWorks 63 (Enabler Rev 3
G- Wind River Workbench Gore 3203

Installation Directory
C¥WindRiver

Disk Space Information
Total Disk Space Required
Disk Space Available

Installation Progress
Tnstallation Gompletz.

127 GB
2801 GB

< Back

X

Gancel

<

To the next page

36

6. Click the | Dezelect all | button.

Select the following items, and click the

[ Mext > J button.

=> For Q12DCCPU-V: "SuperH"
> For Q24DHCCPU-V: "Intel"

Check that "Wind River Workbench 3.2 for
Mitsubishi C Controllers"” has been selected.

Click the [

Tnstall | button.

If the check box is [H] or [ ], keep clicking the box

until it changes to [+].

8. Clickthe | Hext >

] button.
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9. Click the | Next > | button.

® Installer-—readme txt \;‘”E”‘X\

S
=
w,
-
=

Useful “readme” information is provided below

@

10. Click the [ Einigh J button.

Thank you for installing Wind River Warkbench 32 for Mitsubishi G Controllers

Please select the configuration tasks you would like the installer to perform.

® [7][%] Deskiop Shortcuts
= Start Menu Entries

19

Help < Back [ Finsh Gencel

<

Completed

uone|elsu|
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6.1 .3 After installation

This section explains an icon registration, sample programs, and a patch application after the product is installed.

(1) How to start CW Workbench

After the product is installed, [Wind River] is added to [All Programs] in [Start]. "CW Workbench",
"Documentation”, "Product Maintenance", and "VxWorks 6.4.1 Application Developer"/"VxWorks 6.8.1
Application Developer" menus can be selected.

Start the product from "CW Workbench" in the "CW Workbench" menu.

allPrograms B fa wind River Ci Workbench

. Documentakion
off [@)]shut Dow

Product Maintenance
Wiarks 6.4.1 Application Developer  #

Below is a list of descriptions of each menu described above.

(a) Menus to be registered

Menu Description
CW Workbench Starts CW Workbench.
Starts Wind River Registry for Workbench 3.2.
[CW Workbench] Redist When CW Workbench is started, Wind River Registry for Workbench 3.2
i
gistry also starts, except when it is running already. An icon is registered on the
task tray.
Workbench 3.2 Wind River Workbench 3.2 document
[Documentation]
VxWorks 6.8 VxWorks 6.8 document
Uninstalls and updates CW Workbench and applies a patch.
[Product Maintenance] Installation at X YYYY P PP P

(X: drive name, Y: folder name of the installation location)

FTP Server Starts WFTPD.
[VxWorks 6.4.1 Application

Starts HyperTerminal for Telnet connection.

*1
Developer] * or [VxWorks VxWorks COMx VxWorks COMXx cannot be used on the operating system, such as

6.8.1 Application o o
Windows Vista  and Windows 7, where HyperTerminal is not installed.

Developer] 2

VxWorks Development Shell Starts a command line Shell in which the Gnu compiler can be used.

*1: For SW1DND-CWWLQ12-E
*2: For SW1DND-CWWLQ24-E
(b) Sample programs to be registered

Sample programs provided by Wind River Systems, Inc. are installed when the product is installed on the
development environment (personal computer). To check the sample programs to be installed, start the product
and select from the file menu [New] => [Example...].
For details on the sample programs, refer to the Wind River Workbench document provided by Wind River
Systems, Inc.

O [Help]in the menu bar=>[Help Contents]=>"Wind River Documentation" — "Guides" — "Host
Tools" — "Wind River Workbench By Example(VxWorks 6 Version), 3.2"
If the SW3PVC-CCPU or SW4PVC-CCPU has been already installed on the development environment
(personal computer), the sample programs for the C Controller module can be imported to the product and
used.
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6.2 Uninstallation

This section explains how to uninstall CW Workbench and precautions.
Unless operations differ depending on the operating system, windows and dialog boxes of Windows® XP are used for

explanations.

6.2.1 Preparation before uninstallation

(1) Log on as a user with the Administrator attribute when uninstalling the product
on the development environment (personal computer).

(2) Terminate the product before uninstallation.

(3) Uninstall the product in [Product Maintenance].
The product cannot be uninstalled from "Add or Remove Programs" in the Control Panel.
[Product Maintenance] can be executed as follows: [Start] => [All Programs] => [Wind River] => [Product
Maintenance] => [Installation at X YYYY]

X and YYYY of [Installation at X YYYY] mean as below:
X: The drive to which the product has been installed
YYYY: The folder to which the product has been installed
If the folder of the installation location selected upon installation is C:\WindRiver, the menu name is [Installation at C

WindRiver].

(4) Do not stop the processing during uninstallation. If the processing has been
stopped, uninstall the product again.

If the uninstallation processing has failed after the uninstallation processing has been stopped, reinstall the
product. Then uninstall the product again.

39
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(5) For uninstallation on Windows Vista® or Windows* 7, a dialog box asking
whether to enable or disable User Account Control appears.
Click "Allow" or "Yes" to continue the uninstallation.

+ For Windows Vista®

User &ccount Contral ==

'.\1,*,-‘ An unidentified program wants access to your computer
%

Don't run the program unless you know where it's from or you've used it
before.

wilnstaller exe
Unidentified Publisher

* Cancel
I don't know where this program i from or what it's for.

Click "Allow".

<+ Allow
Ttrust this program. I know where it's frem or I've used it before.

) Details

User Account Control helps stop unauthorized changes to your computer.

+ For Windows® 7

"yl User Account Control ==

Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name  wrinstaller exe Click the button.

Publisher: Unknown
File origin: CD/DVD drive

(%) Show details Yes

Change when these notifications appear

40



622 How to uninstall CW Workbench

CHAPTER 6 INSTALLATION AND UNINSTALLATION

Start uninstalling CW Workbench

A5

If the "Wind River Registry for Workbench 3.2" icon

( g ) exists on the task tray of Windows®, select
"Shutdown" in the menu that pops up by right-
clicking the \jg icon.

Click after the following dialog box appears

to terminate "Wind River Registry for Workbench
3.2",

Do you really want to shutdown the Wind River Registry ?
LY

!

fou will not be able to start any new Wind River tools or target servers.

| Yes | [ Mo

A5

Select one of the following procedures:
* When a patch has been applied

= (1)(2)(3)(4) 7 Page 42
* When a patch has not been applied

=> (3)4)[5 Page 43

41
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@ Ci Workbench
[@ Documentation

roians

Sort by Mame

M@ Product Mainkenance

@ Vaworks 6.4, 1 Application Developer

Installation at C

General | Shortcut | Compatibility | Security |

IQ Installation at C windRiver

Target tppe: Application

Target location; #26-win32

Target: ||nsta|ler.e:-: -vmargs -Dallow patch remawal=true

Start in: | C: MfindRiver/maintenancefwilnstaller/s86-win3:

Shartcut key: | Mone |

Rum: | Mormal window Vl

Comment; | |

[ Find Target... ] [ Change lcaon... ] [ Advanced... ]

L 0k J[ Cancel l[ Apply

42

(1)

)

Select [Start] => [All Programs] => [Wind
River]=>[Product Maintenance] > [Installation at X
YYYY]. In the menu that pops up by right-clicking,
select "Properties”.

At the end of the "Target" field on the <<Shortcut>> tab,
add the following argument, then click the

0k, | button.

[Argument] -vmargs -Dallow_patch_removal=true

Point/’

When a patch has been applied and uninstallation is executed without the argument, the [Wind River] => [Product

Maintenance] => [Installation at X YYYY] menu is not uninstalled and remains.
Uninstalling CW Workbench following the steps described earlier can delete the remaining menu.

1S4

To the next page



CHAPTER 6 INSTALLATION AND UNINSTALLATION

(3) Select [Start]=>[All Programs]=>[Wind

[ W Werkbench

&) Docurertation River]=> [Product Maintenance] => [Installation at X

@ Product Maintenance ®  Ihstallation at G WindRiver

M Wind River » @ Wicliorks 641 Application Developer YYYY]

== (4) Select "Remove" and click the [ Mext »

® Installer—Choose Installation Type

WIND RIVER button.

) Product Updates

! Download and apply updates for entitled product

O Patch

F Apply Patches, individual fixes for individual problems,
ovel

@ Rem

@ Remove parts or all installed features,

<

Go to the step 3 ([_5 Page 44)

uopejejsuiun g9
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€ Installer-Remove Details

- Bx]

@ Select features to uninstall

i [)4% Wind River Workbench 32 for \xWorks 6.8 (Enabler Rev 3!

G Vsiorks 641 Application Developer

G Wind River GNLUI Compiler 344 for VaWorks 6.4 (moditied for Windows Vista and Windows 71
(g Wind River Setup 201

(g Wind River Workbench Core 3203

Help < Back Remave Gancel

Point/’

3. Check that items to be uninstalled have been

selected.
Click the button to start the
uninstallation.

If the argument to uninstall the patch has been added in the step 2 (2), select all the items, not only the patch, for

uninstallation.

Note that uninstalling only the patch may lead to improper operation.

® Installer-Remove Details

@ Uninstall completed

@ Wind River Workhench 32 for Vatiorks 68 (Enabler Rev 8)

G wiciorks 641 Application Developer

@ Wind River GNL Compiler 344 for ViWorks 6.4 fmaditied for Windows Vists and Windows 7)
g Wind River Setup 201

& & Wind River Workbench Gors 3203

i Help I < Back Finish Cancel

44
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Completed

. Clickthe|  Einish | button.




CHAPTER 6 INSTALLATION AND UNINSTALLATION

6.2.3 After uninstallation

Some folders and files are left in the folder of the installation location after the product is uninstalled. The remaining
files and files are left to speed up the start-up of the installer when the product is installed again. There is no problem
even if the remaining folders and files are directly deleted from Explorer if they are not necessary.

» Data not to be deleted
Some files including Workspace folders and image files in <Folder of the installation location>.

After uninstallation, a deletion error dialog box shown below may appear when a folder of the installation location is deleted.

Click the ] | button. Restart the development environment (personal computer) and delete the folder of the
installation location again.

Error, Deleting File or Folder r5_<|

@ Cannot delete libwpwrdl: Access is denied,
Make sure the disk is not Full or write-protected

and that the file is not currently in use,

45
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6.3 Update

This section explains how to install the updated license product (SW1DND-CWWLQ24-EVZ), how to operate, and
precautions.

Unless operations differ depending on the operating system, windows and dialog boxes of Windows® XP are used for
explanations.

6.3.1 How to update CW Workbench

Start installing CW Workbench Insert the CW Workbench (SW1DND-CWWLQ12-E)
DVD-ROM into the DVD drive to start the installer.

1. After the installer is started, execute one of the
® Wind River Installer

following operations, and click the DK
button:

Browse...  Enter a folder name of the installation location.

’—%_IDK Carcel | * Click the _ Brawse.. | button to select a folder

of the installation location from the tree view.

Select the YWind River install location:

Point/’

® The following characters can be used for a folder name of the installation location:
» Alphanumeric characters (space cannot be used.)
* Hyphen "-"
» Underscore "
The product cannot be properly installed if characters other than those described above are used for a folder name.

® The dialog box shown below may appear after the O, button is clicked, however, clicking the

Cancel button does not cancel the operation.

& Wind River Installer

Prepaiing installer

) LT

2. Click the et > button.

‘WIND RIVER

e oo [ Heo [ Gl ]
55
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

3. Click the | Next > | button.

® Installer—On-line Update Settines

Ghoose on-line update settings:

[¥]Gheck on-line for latest updates for this installer
[F1Check an=line for latest Wind River product updates:

URL for update repositories
[ntte:s ‘aem/mitsubishi/updatesrepos

[CICannect to intemet using prosy server

[ bep J[ <Bak [ Wexts> J[ gancel |

Point/

If the personal computer is connected to the Internet via a proxy server, check the box of "Connect to internet using proxy
server" and configure the proxy server setting set for the Internet connection on the personal computer.

[Z]Check cn-line for latest updates for this installer
[FICheck orfne for latest Wad Rive product updstes.

URL for updaterepositries
e updat

/mteubihi/pdatesrepos

o= s
hanse oy servr ype:
Oed Proxy  OSOOKS Praxy.
Enter URL information forproxy sever:

P hddess [ ] et [

[T | T | T

sjlepdn ¢9

4. Select "I ACCEPT the terms of this license

agreement.” and click the [ Mext > ] button.

By selecting “1 ASGEPT the terms of this licsnse sgresment” and clicking Nexct, you consent to the
terme of this agreement. If you do ot wish to be bound by the terms of this agreement, click Gancel and
do not install this software,

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE WIND RIVER
PROPERTY AND PROTECTED BY UNITED STATES COPYRIGHT LAW AND
INTERNATIONAL ~ TREATY. UNAUTHORIZED USE, REPRODUCTION OR
DISTRIBUTION IS SUBJECT TO CIVIL AND CRIMINAL PENALTIES.

UOUSGHOM MO o¥epdn 0} MOH | '€°9

BY CLICKING ON THE "I ACCEPT" BUTTON YOU ACKNOWLEDGE THAT YOU
HAVE ENTERED INTO AN AGREEMENT WITH MIT SUBISHI ELECTRIC
‘CORPORATION RELATED TO YOUR USE OF THIS PRODUCT.

04Aprilz010

@TAGCEPT the terms of this license agreement
100 NOT ACGEPT the terms of this lisense agreement

Help ] < Back Hext 2 Cancel

1S4

To the next page
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5. To continue the installation, select one of the following procedures:

If the permanent license file is not obtained

+ Installation using a temporary license (a personal computer can be connected to the Internet)
It is the same installation procedure as the one for temporary license using product with license.
([C5 Page 32)
Enter the LAC (License Authorization Code) written on the License Agreement of updated license product to
LAC on the User Information window.

* Installation using an install key on the DVD-ROM (a personal computer cannot be connected to the Internet)
Note that the installation using the following install key files cannot be executed.
* Install_SH4.txt of SW1DND-CWWLQ12-E
* Install_SH_IA.txt of SW1DND-CWWLQ24-E

If the permanent license file is obtained

Select "Permanent install key file" and click the

WIND RIVER button.
Select the permanent license file from the tree view. Then

click the Mext > button.

O Manually enter all install keys

A5

Go to the step 6 ([_ 7 Page 49)
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

6. select the following items, and click the

® Installer—Choose Installation Filters

[ Mext > J button.

Target Architectures:

Elect orie of ore tareet o processors you plan t Use on your tarest f ol

areu;&ﬂa\n ou may select all of them, |::> For Q12DCCPU_V: "SuperH"
=> For Q24DHCCPU-V: "Intel"

[ Bep  J[ <Back J[ BNet> J[ Goncel |

<

€ Installer-Select and Install Products [[[=1E3)]

7. Check that "Wind River Workbench 3.2 for
Mitsubishi C Controllers" has been selected.

Clickthe [ Install | button.

Products and Features
[ [ 9] Wind River Workbench 32 for Mitsubishi G Gantrallers

If the check box is [&] or [ ], keep clicking the box

until it changes to [+].

Installation Directory
G¥findRiver

Disk Space Information
Total Disk Spacs: Required 127 GB
Disk Space Available 2817 GB

[ e J[ < Back J [ sl [ Cancel |
- N

A5

& Installer-Select and Install Products |;H§HX\

8. clickthe [  MNext > | button.

Products and Features
& | Wind Fiver Workbench 32 for Mitsubishi © Gontrollers
-G dilorks 647 Application Developer
-5 Wind River GNU Gompiler 344 for Vatiorks 64 tmodified for Windows Vista and Windows 7
-k Wind River Setup 201
-5 Wind River Workbench 32 for VWorks 6.8 Enabler Rev 3)
-5 Wind River Workbench Core 3203

Installation Directory
Ci#WindRiver
Disk Space Information
Total Disk Spacs Required 127 GB
Disk Space Available 2801 GB
Installation Proeress
Installation Complete.

A5

To the next page
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Useful “readme” information is provided below:

Cancel

Hel | < Bak  |[_Nea> ]|
i b ] 5

Thank you for installing Wind River Workbench 82 for Mitsubishi G Controllers

Please select the configuration tasks you would like the installer to perform.

Desktop Shortouts
Start Menu Entries

Cancel

Help Bac! [ ]
[ el J[ <Baek | F hb\r[

<~

Completed

50

9. Click the I

Mext =

] button.

10. Click the I

Finigh

] button.




6.3.2

After update

CHAPTER 6 INSTALLATION AND UNINSTALLATION

This section explains an icon registration, sample programs, and a patch application after the product is installed with
the updated license product (SW1DND-CWWLQ24-EVZ).

(1) How to start CW Workbench
After the product is installed, [Wind River] is added to [All Programs] in [Start]. "CW Workbench", "Documentation”
"Product Maintenance", and "VxWorks 6.8.1 Application Developer" menus can be selected.

Start the product from "CW Workbench" in the "CW Workbench" menu.

All Programs

M@ wind River

v @ <

orkbench

Drocumentation 4 '& Reqgistry k

Product Maintenance 3
Waworks 6.8, 1 Application Developer  »

Below is a list of descriptions of each menu described above.

(a) Menus to be registered

Menu

Description

[Product Maintenance]

Installation at X YYYY

Uninstalls and updates CW Workbench and applies a patch.
(X: drive name, Y: folder name of the installation location)

CW Workbench Starts CW Workbench.
Starts Wind River Registry for Workbench 3.2.
[CW Workbench] Redist When CW Workbench is started, Wind River Registry for Workbench 3.2
gisiry also starts, except when it is running already. An icon is registered on the
task tray.
Workbench 3.2 Wind River Workbench 3.2 document
[Documentation]
VxWorks 6.8 VxWorks 6.8 document
FTP Server Starts WFTPD.
o Starts HyperTerminal for Telnet connection.
[VxWorks 6.8.1 Application VxWorks COMx VxWorks COMx cannot be used on the operating system, such as

Developer]

Windows Vista® and Windows®7, where HyperTerminal is not installed.

VxWorks Development Shell

Starts a command line Shell in which the Gnu compiler can be used.

51
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CHAPTER 7 APPLYING PATCH

This section explains how to apply a patch in case it is released in the future.

Unless operations differ depending on the operating system, windows and dialog boxes of Windows® XP are used for
explanations.

Point/’

@® Log on as a user with the Administrator attribute when applying a patch to the product on the development environment
(personal computer).

® Terminate the product before applying a patch.

@® Apply a patch in [Product Maintenance].
[Product Maintenance] can be executed as following: [Start] => [All Programs] => [Wind River] => [Product
Maintenance] => [Installation at X YYYY]
« Xand YYYY of [Installation at X YYYY] mean:
X: The drive to which the product has been installed
YYYY: The folder to which the product has been installed
If the folder of the installation location specified at the time of installation is C:\WindRiver, the menu name is
[Installation at C WindRiver].

® Do not stop the processing during patch application.
Apply the patch again if the processing has been stopped.
® When a patch is applied on Windows Vista” or Windows® 7, a dialog box appears to enable or disable User Account
Control. Click "Allow" or "Yes" to continue the application of the patch.
« For Windows Vista®

User Account Contral ==

'.\ili’.' An unidentified program wants access to your computer

Don't run the program unless you know where it's from or you've used it
before.

@ wilnstaller exe
Unidentified Publicher
¥ Cancel Click "Allow".

I'don't know where this program is from or what it's for.

<+ Allow
Itrust this program. I know where it's from or I've used it before.

) Details

User Account Control helps stop unauthorized changes to your computer.

« For Windows® 7

%! User Account Control ==

@ Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  wirlngtaller.exe H
Publisher: Unknown Click the button.
File origin: CD/DVD drive

v) Show details Yes

Change when these notifications appear
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CHAPTER 7 APPLYING PATCH

7.1 How to Obtain Patch

(1) Download a patch file from the site described below.

[ = Information and services
For further information and services, please consult your local Mitsubishi representative.

(2) Extract the downloaded file and store it in the updates folder in the folder of the
installation location of CW Workbench.

El When the installation location of CW Workbench is C:\WindRiver, the storage location of the patch is
C:\WindRiver\updates.

7.2 How to Apply Patch

Select [Start] => [All Programs] <> [Wind River] =>

[ CW Werkbench

@) Doumertation . [Product Maintenance] => [Installation at X YYYY].

fili Product b nce
3 ) Wiehiorks 641 Application Developer »

® Installer-Ghoase Installation Type Select "Patch" and click the HEXt >

WIND RIVER button.

) Product Updates

. Download and apply updates for entitled product

tch:

atch
’. Apply Patches, individual fixes for individual problems:
move

ORe

@ Remove parts or all inctalled features.

®%

)

yojed ulelqo 0} MOH 1"/

@

To the next page

53



= 3. Check that the patch to be installed has been

€ Installer—Install Updates

selected.

Clickthe | Tnstall | button.

Install Directory Disk Space
Gi¥ifindRiver 11059 KB / 2745 GB
Install Progress
Tnstallation has not started

~ Overall Installation Progress (installed 0 of 0 selected patches)

( ]
Help < Baek Install Cancel

Point/

If the patch to be installed is not displayed, check whether the storage location of the patch file is correct.
+ Patch file storage location
<Install folder>\updates

) 4+ Clickthe [ Finish | button.

; Srosity th udato smrce

~[7] O Workbench Patch Mitsubishi Joon for Windows (11059 KB

Install Directory Disk Space
G¥ifindRiver 11058 KB / 2745 GB

Install Proeress
Installed selected updates successfully

< Back Gancel

Completed
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CHAPTER 8 CREATING AND BUILDING USER PROGRAM

CHAPTER 8 CREATING AND BUILDING USER
PROGRAM

The layout of CW Workbench is shown below.

Menu bar Toolbar

& Device Debug — UserProject/UserProject.c — GW Workbench

e Edit Source Refsctor Mavieate Search  Project Tarest Bun Window  Help
W - B0 B0 F- S @ > vi | B | 5 ) pebonces e [[ >
[7 Project Explorer 57 . % Debue Symbol Browser = O | [ UserProjecte 52 = B | (% Debue =2 =0
0 & < |E #include <vxiorks.h> - =
5 122 UserFroject (hind River VidWorks 64 Downloadable Kemel fiinclude <stdie.h> E >
[ Build Tareets (SHT750zrle - debue) #include <scring.h> "Debug"
& Wind River Launches #include <stdlib.h> & ebug
i #include <taskLib.h>
#;;b Binaries N i . i
i) Include H?ncl\me <\:1:k1.“1 window
(= SHTTEN, " X N ﬂ?nnlude CEYEle " . "
[ ] "Project Explorer’ #include <rime.h Editor
| UserProl . . .
o window #include "GbfFun window brws
#include "HdFunc Heoowy 9 Breakpoints =0
=
"Breakpoints" -
#define MAY DEV NO {31} it BATHAAES «/ P
= window
< | > gfedcha
— —— 0111001
}ﬁ Remate Systems 52 8 -
v
& & = = £ n %
. &£ R & B = Variable |1 Register |6 Express | [ Memary 83 = O
£ Ef Local = - =
@ Wind River Registries E8 Build Corsals 52 @ Ervor Lo ) Prapertiss 8 -
L e 8- 0 PN AN
= -
G Lacal Shells WOTKINE LITECTory: L/ USer/s Mo/ W4 2/ CWW_HOW 107 USErFrojecty o rauenu
:,E VieWorksfix 192 16853 (Wind Fiver Yoiorks 6.4) r;wa[ked reﬁnggpﬁjt:cr;get]s and objects of C/user/ WEAwb3.2 /o HowTo/UserPro]ect/SH??EDgnl - "VarlableS" WlndOW
| ther
if | -d " LzerProject partiall ee”; rm —rf Diebue; fi " . "o
" " if [V =d ““dirname "TserPr I " roject/ Entry WD Tt o™ ™ 11 Reg|sters window
Remote SyStemS bu[lldmg User Project pof BU||d Console o]ecliEntrwaT]nl n]
(1 -d " dimame " LiserPr roject/UserProjecto” © 1t " . W
; d bulldmg UserPro’JectJ)a oject/UserProjecto ExpreSSI()ns WlndOW
window if [1=d " dirmame " UserPr ric limage n” "1 then midi "™ B " wind
building UserProject_p: I
if [V -d " dirnatme ’JUSEFPFEIECt/DEhug/USEI’PI’D]ECt out™™ T then mkdir -p * dlrname UserPre emory rowser” window
building UserProject/Debue/UserProject.out
make: built targets of O/user/ WSAub32/cwm_HowTos User Project/SHT780enule
Build Finished in Project ‘UserProject: 2010-08-26 09:15:06 {Elapsed Time: I]—
5 | 3
o* e AE R : 20Mof 430 ] ¢

The layout of each window can be changed by dragging with the mouse. The layout shown above is the default layout.
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8.1 Creating Project

(1) How to create a project

1. To startCW Workbench, select [Start] => [All

Programs] => [Wind River] => [CW Workbench] =>
[CW Workbench].

% Workspace Launcher :

Select a workspace @ "Workspace:".(A folder can be also selected from

the tree view by clicking the = Browsze... | button.)

Browse. .. . A
S ] Clicking the ak. | button starts CW
Mote: The workspace directory must be writable,

and should be located on Fast {local) storage.
Workbench.
[Juse this as the default and do not ask again

Enter a folder of storage location of workspace for

CW Workbench stores your projects in a folder called a workspace.
Chaose a workspace folder to use For this session,

Workspace:

A message box shown below may appear. Click the ] | button.
® Warnine El

Wind River Registry created a new database at

! 'GeWindRiver Awvind fwtxreed hostname'
If wou have been using Wind River Wiorkbench before, and you want to
mierate your old tareet connections, please quit Workbench and the
Reeistry now, search for the file named 'wtxreed hostname' in vour ald
installation and copy it to the new location.

For details, see the Online Help.

100 nat show again

@

3. Select from the menu bar [File] => [New] => [Wind
River Workbench Project...].

4 Basic Device Development — — CW Workbench
Edit Source Refactor Mavieate Search  Project Bun  Window  Help

Open File,. [ Project..

To the next page
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CHAPTER 8 CREATING AND BUILDING USER PROGRAM

: 4. Sselect the following item for "Target operating
% Mew Wind River Workbench Project [= EJ
button.

Target Dperating System
Select the target operating system for the project.

rN
—

Tareet operating system: |Wind River Willorks 6.4
: T Fi

@ < Back i

Cancel

1S4

s Mew Wind River Workbench Project

Build Type
Select the build type for the project.

Downloadable Kernel Module

ne| Module
oy Feal Time Process Application

Dezcription: |Rglinkable Kernel Module

Shared Uszer Library

Static Kernel Library

Static Uszer Library

Uzer-Defined

Mone

Build tvpe:

Setup information
Fezulting project type: Downloadable Kernel Module Project

Uzed build tool: Linker

@ < Back || ﬂext),\g i
2

GCancel

<

To the next page

5.

system:". Click the Mext

=> For Q12DCCPU-V:
"Wind River VxWorks 6.4"

=> For Q24DHCCPU-V:
"Wind River VxWorks 6.8"

Select "Downloadable Kernel Module" for Build

type:". Click the Mext button.
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s 6. Entera project name for "Project name:" and click
% Hew Wind River Workbench Project | |
Project the | Finizh button.
Create a new project with the specified data. " : m
UserProject" has been entered here as an example.

Project name: | IEEHETe e

Location
(%) Create project in workspace
(O) Greate project at external location

() Greate project in workspace with content at external location

Browse...

@ Mext > l Finigh kg [ Cancel
X

.

Point />

If characters that cannot be used or a project name that is already used are entered for "Project name:", an error text
appears on the header of the window and the [

Einizh ] button becomes disabled.
« If space is included in the "Project name:", the following error message appears.

i Mew Wind River Workbench Project =1E3]
Project

@ is an invalid charaster in project name ‘User Project’ B

Project name: |12

Location
(&) Create project in workspace
) Create project at external location

) Create project in workspace with gontent at external location

Browse.
@

« If a project name that is already used is entered for "Project name:", the following error message appears.

4 New Wind River Workbench Project

Project

@ A project with that name akeady exists in the norkspace. B

Project name: |12

Location
(&) Create project in workspace
) Create project at external location

) Create project in workspace with gontent at external location

Browse.
@

In addition, a space entered at the end of the project name is dropped.
El "UserProject "— "UserProject"”

<

To the next page




CHAPTER 8 CREATING AND BUILDING USER PROGRAM

On the "Project Explorer" window, select a project

\s Baszic Device Development — — GW Workbench
File Edit Source Rsfactor Naviests Search |Ii Run Window Help where properties should be set. With the project
: 4 - = = - i 8. .
f’j o % g - Froject Feferences selected, select from the menu bar [Project] =>
[ Project Explorer 3 B g B GCloge Project P .
. _ = roperties].
= f M Open Wind River VaWaorks 64 Development Shell [ p ]
&y Build Al L
Build Project t
Glean...
Build Options

Select [Build Properties] from the tree view to the

& Properties for UserProject

beetieree | euid Properties — left on the window, and click the <<Build Support

Resource
Specify all build properties. R .
< @ Build Support and Specs | g Build Tools | $ Build Macros | (= Build Paths | @4 Libraries and speCS>> tab. Check that the f°||°W|ng item has
Build support . .
S Sonerel @ Wansged buld  Crskefiles cenerated by the IDE} been selected for "Available and enable build
;;t;]ect Raleﬁnces ) Disabled "
actaring History specs:".
?:;‘k/ DTZ:L: Settings Build command: [gmakepreficth make —no-print-drectory P
Validation
Available and enabled build specs:
SHTTS0srule Enable All => For Q12DCCPU-V:
Disable Al " "
SH7750gnule
=> For Q24DHCCPU-V:
Rer
= "PENTIUM4gnu"
Default build spec: |[SHT70grule ~|
Active build spec: [SHT7E0gmule ~]
I%)ehug mode.

Restore Defaults Apply
@

©

Point 0
® When the project has been imported, unsupported build specifications may be displayed for "Available and enable build %_
specs:". Q

Since this product supports only the following build specifications, clear the check boxes other than the following build 5-?
specifications. ‘(_q;'

=> Q12DCCPU-V: "SH7750gnule"
=> Q24DHCCPU-V: "PENTIUM4gnu"

@ The default is in the debug mode. Clear the "Debug mode" check box during operation.

<

To the next page
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60

& Properties for UserProject =3
[tpe filter text Build Properties &= v
Resource
By Paser Specity all build properties.
@ Build Support and Specs | ##* Build Tools | $ Build Macros | (5 Build Paths | i Libraries
G/C++ General Fedirection root directory: | ]
Project Info
Project References Mote: Leave this field blark to store build output together with the sources, or enter an absolute
Fefactoring Histary path (envircnment variables are permissible) to rediect the output
- Run/Debug Settines Build spec specific settings
- Task Taes Astive build spec: [SH7760gnuls v
Validation
Redirection directory: [SHT750snule ]
# Tholude paths:
Inchude directories Generate..
I OWIND_BASE)/tareet/h )
-IWIND BASE} tarast/h/urny/ coreip l;
A to all
Remove from all
Up
Restore Defaults Apply.
@
% Add include search path to selected build spec E
Walue:

Select directory

Al

= [ MELSEC -

SRR
I CCIEC -
I SCLIME
[ CCPUTOOL
= 1) Dvx
o

=1 Trand=
] | ¥

=

Folder: | Indlude |

[Make Mew Folder ] L K J [ Cancel l

9. select "Build Properties” from the tree on the left of
the window.
Open the <<Build Paths>> tab and click the

[ fidd. button.

10. Click the button.

11. Select the include folder on the "Select directory”

window.

Click the k. I button.

The following are the paths for the include folder.

® When SW3PVC-CCPU compatible with Q12DCCPU-V is installed in "C:\MELSEC"

"C:/Melsec/CCPU/DVx/Include"

® When SW4PVC-CCPU compatible with Q24DHCCPU-V is installed in "C:\MELSEC"
"C:/MELSEC/CCPU4/Q24DHCCPU-V/Include"

<

To the next page



CHAPTER 8 CREATING AND BUILDING USER PROGRAM

- 12. Check that the folder specified on the "Select
& Add include search path to selected build spec ['Xl directory” window has been selected.

Walue: Click the k. button.

|—IO:!MELS EC/CGCPU/ DV Tnclude

[ Browse. . H oK [:\VH Cancel

7 13- Check that the include path of MELSEC added to

Build Properties "Include directories" in [Include paths:] appears.

Resouvce
Binary Parser

Specify all build properties,
Build Properties @ Build Support and Specs | 5 Build Tools | $ Build Macros | (= Build Paths | =i, Libraries Click the (] button

Builders
g/c“ (;;ng,al Redirection rost directary: | ]
raject Info
Project References Hote: Leave this field blark to store build autput together with the sources, or enter an absalute
Refactoring History nvironment variables are permissible) to redirect the output.
Fun/Diebue Settings Build spee specific settings
Task Taes Active build spec: | SHT760gnule ~|
Validation
Redirection directory: [SH7750gnule | [Default

# Thclude pathe:

Generate.

|

Ihclude directories

—(WIND BASE)/Iargt/h _—
fl}ﬁ(WIND EASE)/Iarget/h/wm/cure\p

Restore Defaults Apply

®
Point/>

Click the k. button. If the following message box appears, click the

| button.

% C/C++ Index configuration changed

The C/C++ index needs ko be rebuilt ko reflect the build property

J} changes you just made.

Do you wish to rebuild the index now?

109loid Buneasn 1'g

[ remember my decision

<
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74. on the "Project Explorer” window, right-click a
e project where a file is added. Select from the pop-up

Eile Edit Source Refactor Mavisate Search Project Bun
menu [New] => [File].

&~ B P

EEA O o
[ Praject Explorer £
e s

=4 Project

Go It
o e [ Build Tarest
2 Copy ko [ 07D
B Fil=
% Delete Delete % File from Template

Point/

Various files can be added to the project using the new file addition function ([File] => "New" => "File") or "Refresh".
However, note the following before adding files to the project:

® Do not add projects with the same name as the project name.
@ |[f a file with the same name as the project name exists in the project, do not use the "Rename" function of CW

Workbench for the file.
» Delete the file from the project if possible. (Note that the file is also deleted from the hard disk.)

» Change the file name on the Explorer if the file cannot be deleted. After changing the file name on the Explorer,

execute "Refresh” in the pop-up menu of the project.
« If a file name is the same as a project name and is changed using "Rename" of CW Workbench, the build

cannot be executed.

2V

15. Enter a file name of a source file for "File name:".

W New File |- 121X
File Click the Einish button.
Create a new file rezource. )

"Sample.c" has been entered here as an example.

Enter or zelect the parent folder:

| UzerProject

1= RemoteSystemsTempFiles
=5 UszerProject Mind River Works 64 Downloadsble Kernel Module Proj

<
File name: | SETHER |

Advanced >>

@ l Einisht\rl[ Cancel
<

To the next page

62



CHAPTER 8 CREATING AND BUILDING USER PROGRAM

Point />

+ Enter a file name with extension (.c, .h, .cpp, .hpp) for "File name:"

» Do not use two-byte characters for a file name. Do not execute the compile for a file that has a name including
two-byte characters, or a compile error occurs.

« If characters that cannot be used or a project name that is already used are entered for "File name:", an error

text appears on the header of the window and the [ Einizh ] button becomes disabled.

& New File (=13
File

@ 7 is an invalid charaster in resource name ‘Samp?lec’

1=

Enter or select the parent falder:

[UserProject ]

& RemoteSystems TempFiles
{5 UserProject (Wind River VWorks 64 Downloadable Kernel Module Proj

< | B

File name: [Samp7lec |

@

76. Edit the source files on the "Editor” window and

Fie Edt Source Refactor Navigate Search Project Run Window Hel . . . .
’ ’ ’ include the following include files:

- & @it 0- i@ (AEm #- G =3
[ Project Explorer 52 = O/ [g) sample.c £3
m Elm e e T e, O A12DCEPUY
BE;gg,;*;;,;ﬁ;:;ﬁ;g;:;;f5-“”””‘“‘“‘** * Bus interface function: "QbfFunc.h"
4 Binaries . .
By * MELSEC data link function: "Mdfunc.h"
B Ut ol = For Q24DHCCPU-V
| Makefie . . " n
15 Sampoc » Bus interface function: "QbfFunc.h

* MELSEC data link function: "Mdfunc.h"
» C controller module-dedicated function:
"CcpuFunc.h"

A5

Completed

109loid Buneasn 1'g
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(2) Adding source file

Follow the instructions below to add a source file that has been already created to the project.

1. Copy the created source file to the current folder of

&% C:\UserProject

a project to be added.

File Edit ‘iew Favorites Tools  Help -W
- »
@ Back ~ () l.@ p Search E’— Folders ' E
Address |[3) CiiUserProject v B &0
| | & Copy EntryWDTInt.c to the current folder of the
Folders * Mame =
5 3 UserProject | [E5mmmTgnu project to be added (UserProject) on the Explorer.
= [ SIMNTgnu ) commonDef.h
= [5) UserProject
[23) Debug D E] Sample.c
[ UserProject_partiall
(£3) WINDOWS 2
< i | 3 i | »
Type: C File Date Modified: 3/23/2010 2:57 4.89 KB i My Computer

Select the project to be added on the "Project
Explorer" window. Select "Refresh” in the pop-up

menu.

=
I@] E:agopy Citr [+
i [ Paste Citr |+

[ | 3¢ Delete Delete

Fename F2

Move...

Attributes 3

£y Import..
£ Export..

Open Wind River Wx\Waorks 6.4 Development Shell
** Build Project Cirl+Shift+A
A Rebuild Project

Build Options 3

3. Thefile "EntryWDTInt.c"” copied in the step 1 has
been added to the project.

Build Tareets (SHTTEDEnUle)

iy Wind River Launches

=4 Binaries
UserProject_partiallmagen - [shile] GHITE0znule)

[&} UserProject partiallmazen - [sh/le] (SHT750enule - debug)

UserProjectout - [zhle] (SHTTE0enule!

“-[Gh UserProjectout - [sh/le] SH7750enule - debug)

- fajll Includes

-z SHTR0erule

< ----- g Entry'WDTIhtc

=

Completed
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8.2 Adding Project

In CW Workbench, multiple projects can be managed on the same workspace by adding other projects following the
instructions below.

El Adding a C Controller module sample project (EntryWDTInt)

1. Right-click on the "Project Explorer” window and
& Basic Device Development — UserProjectsSampl
select "Import...".

File Edit Source BRefactor Mavigate Search  Project

0 i i | W@ 4B
Tﬁ_ﬁ Project Explorer 53 = Q:“b -~ 7O
= [;:-H zerProject Oiind River WeWorks 6 N R
-l Build Tareets (SH7750enule? =
--ls Wind River Launches Go Into
|@.| Ihcludes B Copy
o] Samplec =
EEI Paste
¥ Delete
Rename
Move...
Attributes
e Export.. g
o
<5 9
2. select"G | E P g
. Select "General" > "Existing Projects into a
% Import g ) g
Workspace". o
Select 3
Create new projects from an archive file or directory. | E\J 5 | Click the HEXt ) button. g

Select an import source:

|type filter text |

== General
..... [E, Archive File
..... Build Settings

3

----- Ty Perspectives

----- E, Preferences

#ﬂ Wind River Target Connections

----- B Wind River Workbench Breakpoints
= AT+
[]...B [T
= Desktop
E

£

t -7 Remote Systems
H-(= Fun/Debug
(= Team

-2 Vidiarks Bx

£

®

To the next page
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(=13

Browsze.. [:

% Import

Import Projects

Select a directory to search for existing Eclipse projects.

L

() Select root directary: |

|
() Select archive file: | |

Browze..
Projects:
Select All
[ Copy projects into workspace
‘iforking sets
[] Add project to working stz
Workine sefe: Select..

Mext > Finigh

Cancel

Browse For Folder

Select rook direckary of the projects ba import
) sntpTimeset &
= |5y QBFtest
I cFcChange
(&} et wDTin: S
IC=) MotionLink
I3 QEFMessage
I Seript
5 v v
< I | =
Ealder: | EntryWDTInt |
[ Make Mew Folder ] L (8]4 J [ Cancel ]

<

To the next page
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3. Sselect "Select root directory:" radio button and click

the EBrowze.. |button.

4. select the folder where the project to be imported is

stored and click the (] 4 | button.



CHAPTER 8 CREATING AND BUILDING USER PROGRAM

D At ofthe prlect stord n the fader (ncluding
& Import .
= — subfolders) specified in "Select root directory:" is

Import Projects A W A " .
Select a directory to search for existing Eclipse projects. @ dlsplayed in PrOjeCtS. . Check that the PrOJeCt to
- be imported has been selected.
) Select ract directory: |CAMELSEG|GOPLUVGGPLUTOOLISample\ 0] [ Bromee., | Click the [ Einizh button.

() Select archive file: | |

Projects:

EntryWD TInt (C:\MELSECAGGPUNGCPUTOOL Sample) DVAG] [ Select Al

Decelect All
p 3

[ Copy projects into workspace

Warking sets

[ Add project to working sets

@ Finizh H Ciancel ]

Point/’

When a project created in Wind River Workbench 2.6.1 is imported, the following message appears.

Click the [ | button.

& Project Mieration

9 ) Existing project description files in this workspace have to be converted

\V to the new Workbench format. If these files are not converted, some
functionality may be compromized. Converting projects may make theze
incompatible with older Workbench versions.

Caonvert now?

[ ez | [ Ho ]

108foid Buippy Z'8

The following warning message appears on the header of the window when there is no project that can be imported in the
specified folder.

Import Projects
& Mo projects are found to import B

A5

To the next page
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6. The specified "EntryWDTInt" project has been
s Bazic Device Development — CW Workbench
File Edit Source Refactor

- - imported to the workspace.
Mavigate Search Project  Bun

B - FTIEE = dl ¥ R SR =

i = aY

I}‘:, Project Explorer &7 |

Entry 0TIt Whind River Wiiorks 6 :
Elf“D-H UserProject (iind River Wotiorks 6.4 Downloadable |
@) Build Tarzets (SHT7A0enule — debue)
@ Wind River Launches
--cﬁb Binaries
@]:I Includes
#- = SH7750znuls

boo[d] Samplec

6.4 Downloadable

<

Completed



8.3

How to Build Project

CHAPTER 8 CREATING AND BUILDING USER PROGRAM

Follow the instructions below for how to build the project.

1.

& Basic Device Development - UserProject/Sample.c — GW Workbench

File Edit Source Refactor Mavigate Search  Project Bun  Window Help

A il wilg P %-0- g1 i - e
[ Project Explorer 53 5 g~ T = 0| Getting Started (] Sam
E= ;
l Build Tareets (5H70enulsy | LeW
I Wind River Launches Go Into
! Iheludes —
[€] Sample.c = Copy Gl
¥ Delete Dizle
Rename F2
Mave
Attributes
g Import..
£ Export..

Open Wind River Wiorks 64 Development Shell
#* Build Project Citrl
' Rebuild Project

Build Options

Ciloge Project g

& Basic Device Development — UserProject/Sample.c — CW Work )

File Edit Source Refactor Mawvigate Search  Project Bun  Window F
il M -0 g |1l i
[7 Project Explarer 53 [=| Q:b P ogd- 7 T 0|y Gettine Sta
2 2] It N
Wy Build Tarestd  —
(@5 Wind River |, G0 Into
i heludes -
1= Gy Citrl
[ Samplec At
¥ Delete Delh
Fename F2
Move..
Attributes
£2g Import..
1 Expart.
Open Wind River Wxborks 64 Development Shell
#** Build Project Citrl

= Febuild Proj

Build Options k

A5

To the next page

On the "Project Explorer" window, right-click on a
project name to be built. In the menu that pops up,
select [Refresh)].

On the "Project Explorer" window, right-click on a
project name to be built. In the menu that pops up,
select [Rebuild Project].

69
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rs_(] 3. Ifthe message shown to the left appears, click the

\y ‘ou may need to set the include search path for ‘UserProject’ If the L Ciontinue J button.

% Build

included files are unambiguous and visible in the workspace, you can
generate the path now and the build will proceed.

To manually set the projectz build properties, cancel the build. To
proceed without generating the include search path, click Continue.

[Generate Inc:ludee...] [ Cancel ] | Continue

v [ s ) o ) B s elEl Wi 0%AEE0 4. The build process is displayed on the "Build

W k g, make o printd r}ln kaIJ[lD,ﬁPE(; SH‘I“I;gﬁr_lIl%ISenDEBIJG MODE=0 TRACE=1 clean all Gl

Iake oo ogete and ot ot Gy e et Poject AT RDgrle Console" window.

if [-d " UserProject” ] then od ” usevaAect rm —rf NonDebue; fi

|:%‘-d"us vPvmeE&ﬁzm;llmag‘e T then cd | LlsevvaectO)Lamz\lmage rm =rf NorDebue; Qi e i oy  UserP & partiall MonDebue /Objests/UserP

i ™St i et s s ottt Build Finished..." is displayed after the build is

i: 7 marln,e usefﬁales/saneﬂmg/\ﬁlsevPrayechm« ']Ihen mkdir -p " dirname * £, fiecho “building e

Userl ject/NonDebug/UserProject.out H H H
et e T S completed. Check for error indication (red) on the

[l

< |

Point/’

|
I~

"Build Console" window.

If the following error "command not found" occurs for the build result, an unsupported compiler may have been used.
Check that only the following build specification has been selected for the <<Build Support and Specs>> tab in [Build
Properties] of the project. If check boxes of build specifications other than the following have been selected, clear them.
(=" Page 56, Section 8.1)

> Q12DCCPU-V: "SH7750gnule"

=> Q24DHCCPU-V: "PENTIUM4gnu"

Build Gonzale 57 Sl Feeds (43 ) Ervor Log | B Gonsale =0
£5- m |[& $ %48~
building UserPmjecl/Debug/Ob]ecls/UserPru]ect/Sample o ~

CHDOCUME™" PS32965%L0OCALS ™ Temptmake1 4208 sh: dec: command not found
BCAMAOP Bywanorks-6.4hostudi-windybinmake.exe: #%¢ [UserProject/ Debue/Objects/UserProject/Sa
Build Failed in Project 'UserProject’ {Process Exit Value was 2):  2010-07-29 13:18:01 IC

@ |[f the build result has an error, error information (source file name, line number, and error details) is displayed in red.
Correct source codes in the error part.

Execute the build again after correction. Repeatedly correct and build the source codes until the build result is not

colored red.
E3 Build Console 52 @] Errar Loe | =] Froperties =g
s-=@ ¢ i4%[4HEE 7
WOTKINE DIFECTOTY: GI/USery_Wo/ WO 5.2/ CHW_HOW 10/ USerTT0ject/ or i Fougnule =
make: removing targets and obj ects of C:fuser/ WS7wh3.2/cww_HowTos User Project/SHT780enule -

if [ -d “UserProject” 1; then cd UserFrDJect rm =rf Debue; fi
it [-d" UserProJecSpart\alImage I then'cd ™ UserPro]ectpartla\Image rm —+f Debue; fi
it [1 - "“dimame “UserProject partiallmage: Debue /Objects/User Froject/Samplea” 1. then mkdir -p " dirname *
building UserPm]eclparl|aIImage/Dehugth]ectlelserPrn]ach’SampIe o
C/uger/ WS /b3 2/cw_HowTod User Project/Sample.c: In function *UserProject

@C:/uzer /WS Awh3 2/ oo How Tod User Project/Sample.=09: eror: stray 129 in program

30 /uzer /WS Awb3 2 cww_HowTos User Project/Sample.c:09: stray '@ in prosram

BC: \WR\C\'\/’W\vanrks—ﬁ4\hnst\xEﬁ—meZ\h\n\make exe: #+k [UserProject partiallmage/Debug/Objects/User Projer.
Build Failed in Project 'UserProject’ (Process Exit Value was 2f 2010-08-26 10:28:33 (Elapsen—

< | >

Double-clicking the error line where a source file name and a line number are displayed jumps to the error location of
the source file.

<
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CHAPTER 8 CREATING AND BUILDING USER PROGRAM

5. Atter the build is completed, execution file (user

& NonDebug BX
Ae EE W Cewmles Twb MR [T program) to be used on the C Controller module is
e Back - d L@ /':j Search |\ Folders v created.
Address @C:1WindRiver\workspacelUserPro]'ectISH??SDgnuIe\UserProject\NonDebug V| Go If an error occurs durlng the bu“d’ a user program
|2 Mame Siee | Type is not created.
File and Folder Tasks % @ctdt.c 1 KB Tornado
) " Betdeo LKB OFle A file name of the user program is "<Project

@ Rename this Fils {KB OUT File

By Move this file name.out>".

) Copy this file 7€ 3

Folders where a user program is created:

® In Debug Mode:

> For Q12DCCPU-V:
<Workspace folder>\<Project name folder>\SH7750gnule\<Project name folder>\Debug

=> For Q24DHCCPU-V:
<Workspace folder>\<Project name folder>\PENTIUM4gnu\<Project name folder>\Debug
® In Release Mode:

o> For Q12DCCPU-V:
<Workspace folder>\<Project name folder>\SH7750gnule\<Project name folder>\NonDebug

=> For Q24DHCCPU-V:
<Workspace folder>\<Project name folder>\PENTIUM4gnu\<Project name folder>\NonDebug

When a user program is created on a project imported, the folders above change depending on structures of folders and
projects where the imported project exists.
Check the folders where a user program is created on the imported project.

1S4

Completed
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8.4

Setting Optimization Option

This section explains how to set an optimization option that prioritizes the processing speed.

A4 Basic Device Development — UserProject/Sample.c — CW Workbench

Eile Edit Source Refacior HNavieate Search
il wil m {%-0-
ff_j Project Explarer 57

8w

i

[ Build Targsts SH77E0rule)
(s Wind River Launches

tg’ Binaties

& heludes

H (= SHTTElenule

i [ Samplec

1.

Bun  Window Help

Cipen Project

Project References

Giloge Project

Qpen Wind River WxWorks 6.4 Development Shell

[5ap Build All !
Build Project 1

Clean..

Build Options

<

% Properties for UserProject

2.

Build Properties -
Resaurs Specify all build properties.
@ Fuild Support and Specs | 4 EUK Tooks | $ Build Macros | (= Build Paths || = Libraries |
ders
[ CAC++ General Build tool: |G-Campiler New Rename. Gapy. Delete.
| (e (B ) ()
- Project References
- Refactoring History Suffices: ke |
| Fun/Debug Settines
 Task Tas Build output generation
* - Validation (& Generated build output is an object
) Generated build output is a build target
Build tareet can be passed
Build spec specific settings
Active build spec |sH77508rle -
Derived suffic [ra ]
Gommand: @ [echo "building $3" Kecompilerprefixk HTOOL PATHIcesh & -~
DiebugMode Flags ¥ToolFlassk $(ADDED GFLAGS) #hcludes =
$(ADDED_INGLUDES) -DGPL=$(GPL} - =
DTOOL_FAMILY=5TOOL_FAMILYY -DTOOL=$TOOL} -D WWRS_KERNEL
Tool Flags & [${GC_ARCH SPEG) —ansi —Wall —MD -MP ‘
Debug mode flags
Debug mode. | @ & |
Non Debug mode..| # [-02 —fno-buittin ]
Restore Defaults

<

To the next page
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Select a project where the optimization option is

set. Select from the menu bar [Project] =>
[Properties].

Select [Build Properties] from the tree view to the
left on the window.
Click the <<Build Tools>> tab.



% Properties for User

[petieiee || puild Properties

Resource
Binary Parser

Build Properties
Builders

GG+ General
Praject Info

Praject References
Refactoring History
Fun/Debug Settings
Task Taes
Validation

&

Project

-
Specify all build properties.
@ Build Support and Specs | #* Build Tools | $ Build Macros | (= Buid Paths | =), Libraries
Build tool: |C-Compiler Rename.
C-Gompiler
Suffixes  |Linker
Fartial Image Linker

Build outp| h\hvaﬂahn‘

® Genersted BT 0

O Generated build output is a build tareet

Build target can be passed

Build spec specific settings

Active build spec: |sHT7508nule v

Derived suffix [*o |

Command & [echo “building $@° Necompilerprefi ${TOOL PATHIcesh % A
Debughiodz F laes® KToolFlagsk $(ADDED OFLAGE) Kincludesk —
$(ADDED INCLUDES) ~DGPL=§IGPLY - =
DTOOL_FAMILY=3(TOOL_F AMILY) -BTOOL=$(TOOL) -D_WRS KERNEL &

Tool Flags. & # [$00C_ARCH SPECY -ansi -Wall -MD -MP

Debug mode flags

Debug made 7 [ |

Non Debug mode..| & |-02 ~fno-builtin |

Restore Defaults

% Gnu Compiler Options

CHAPTER 8 CREATING AND BUILDING USER PROGRAM

3. Sselect "C-Compiler” for "Build tool:".

Click the Toal Flags...

button.

Select "C++-Compiler" for C++.

A5

Spesify flags for: | Tool Flags

Debuge ine
My
= Gompilation
Output
Syritax
= Types
Integral
Disgnostics
int

Optimization
Enable optimization
& [JEnable standard speed optimizations
| [“]Enable maximum speed optimizations
# []Emphasize space reduction over speed requires one of the ahove)
Optimized cade generation
& Inline functions with less thar: nodes
# Maximum size of a laop for unralling nodes:
# [ Loop strength reduction and elimination of iteration variables
# []Combine an instruction that copies one register into another
# [Generate position-independent code
@ [ Reorder instructions to eliminate exscution stalls
& [Den't keep the frame pointer in a register for functions that don't need one
# Stack:

(O Pop the arguments to each function call as soon as that function retums.

& Unrall loaps

O Almays
@® Never

@ hceumulate areuments on the stack for several functian calls and pop them all at once

O rumber of iterations can be detsrmined at compils tims o upon entry 1o the loop

&3

Selected option
-02
$CG_ARGH SPECH

4.

On the "Optimization" dialog box, select [Enable

maximum speed optimizations]. Check that "-02"
has been added to "Selected option:" and click the

0k, button.

Point/

To cancel the optimization option, click ./ | in "Enable Optimization" on "Optimization" and change the mark to

¥ (cancel). Check that "-O*" has been deleted from "Selected option:".

<
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[type tilter text

- Resource
Binary Parser

| Project References
- Refactoring History
- Fun/Debug Settings
| Task Tags
*Validation

Build Properties -

Specity all build properties:
& Build Support and Specs | ' Build Tools | $ Build Macros | (= Build Paths | &4 Liraries

Build tool: [G-Compiler

Suffices: [+

Build output eeneration

@ Generated build output is an object

(O Generated build output is 3 build target
Build tareet can be passed

Build spec specific settings

Active build spec: |SHT7508r0le -

Derived suffic [*o ]

Command: & [echo "building §3" Aecompilerprefix ${TO0L PATH)ccsh % -~
DebugModeFlazsh ¥ToolFlaesk $ADDED GFLAGE) Mncludesh =
§(ADDED JNGLUDES) ~DCPU=$(CPL) - =
DTOGL_FAMILY=5TOOL_FAMILYY -DTOOL=RTOOL} -D WWRS_KERNEL ¥

Tool Flags # [$15C_ARCH SPEG) -ansi -wall -MD -MP

Debug mode flags
Debug made.. | & |e |
Non Debug mode..| # [-02 —fno-buittin ]

Restore Defaults Anply

Check that "-0O2" has been added to [Tool Flags...] in

"Build Properties” and click the ak I

button.

After the k. | button is clicked, the following

message appears. Click the

& C/C++ Index confieuration chaneed

The G/G++ index needs to be rebuilt to reflect the build property
\) changes you just made.

Do vou wish to rebuild the index now?

[1Remember my decision

[ es k-‘ [ Mo

-
—
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CHAPTER 9 CONNECTING CW WORKBENCH TO THE C CONTROLLER MODULE

CHAPTER 9 CONNECTING CW WORKBENCH TO
THE C CONTROLLER MODULE

9.1 Setting Target Server

The host (CW Workbench) and the target device (C Controller module) communicate through the target server (on the
CW Workbench) and the C Controller module.
Below is a setting procedure to establish communication.

Host Target device

4 N e I

iQ Platform-compatible

Development environment C Controller module
(personal computer)

CW Workbench

( Eclipse framework )

Eclipse
C/C++ Development Tools

( Target server )

Windows

( Ethernet )

Janleg 10ble] Bumes 1L'e
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9.1.1 Preparing for target server setting

The following settings are required for CW Workbench to connect to the C Controller module through the target server:
+ Setting an IP address of the C Controller module
+ Setting a VxWorks image file

The files must be
the same!

Development environment (personal computer) \ C Controller module
IP address:192.168.3.1 IP address:192.168.3.3

Point/’

A VxWorks image file to be set in CW Workbench must be the same as that in the memory for the C Controller module

system. For how to check if the files are the same, refer to (1) below.
If not the same, acquire a VxWorks image file from the memory for the C Controller module system and set it on CW

Workbench. Refer to (2) below.

(1) How to check if VxWorks image files are the same
Check that file names of the VxWorks image files listed below are the same.

» CW Workbench side
=> For Q12DCCPU-V: C:\MELSEC\CCPU\DVx\Tools\Q12DCCPU-V_XXXXX-Y "2
=> For Q24DHCCPU-V: Acquire VxWorks image file from the C controller module using FTP.

((Z5 Page 76 (2))

+ C Controller module side

=> For Q12DCCPU-V: /SYSTEMROM/OS_IMAGEFILE/Q12DCCPU-V_XXXXX-Y 1

&> For Q24DHCCPU-V: /SYSTEMROM/OS_IMAGEFILE/Q24DHCCPU-V_XXXXX-Y !

*1 XXXXX: First five digits of the serial number of the C Controller module
Y: Function version of the C Controller module
For how to check serial numbers and function versions, refer to the following manual.

[ 71 C Controller Module User's Manual (Hardware Design, Function Explanation)
*2 This is a path when the SW3PVC-CCPU is installed on "C:\MELSEC".

(2) How to acquire a VxWorks image file from the C Controller module
Refer to (1) above and use the FTP to copy a VxWorks image file on the C Controller module to a folder on the
development environment (personal computer).
Do not copy the VxWorks image file to a path or a folder that has two-byte characters and katakana.
A VxWorks image file of the C Controller module is stored in "/SYSTEMROM/OS_IMAGEFILE".
Below are the default user name and password to connect CW Workbench to the C Controller module using the
FTP:
* User name: target

* Password: password
If the default user name and password have been changed, use the user name and the password acquired.
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(3) Checking the network connection
Before setting the target server connection, use the ping command to check that the C Controller module, a
destination of the target server, is connected to the development environment (personal computer) by following

the instructions below.

1. start [Command Prompt] from the start menu on the

development environment (personal computer).

=+ Command Prompt

2. Execute the ping command.
Use the IP address of the C Controller module for
the IP address specified for an argument in the ping
command.
The default IP address of the C Controller module is
192.168.3.3 if not changed.

<. Command Prompt

3. Check that the development environment is

network-connected to the C Controller module.

Janleg 10ble] Bumes 1L'e

4. Execute the exit command to terminate the

Command Prompt.

Buies Janlas jobley Joy Buledald |16

Completed
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9.1.2 How to set target server connection

Follow the instructions below to set the target server connection.

1. Click the _i’ button on the toolbar of "Remote

j{ﬁ Remate Systems 3 T Kernel Objects} = H
e g alooa|B|l&T Systems".
Ef Local.

5 2. Select "Wind River VxWorks 6.x Target Server
°

Select Remote System Type Connection" and click the [ Mext >

:ll_'LZ button.

|type filter text |

System tvpe:

F-(= General

-2 Vitarks fx

#@ ind River Wxihiorks Gx Core Dump Connection
..... -Rwind River < Target = Connection

@

To the next page
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3. Ssetthe target connection information for "Backend

Target Server Options Settings" as shown in the list below.

I, Selected processor will be wsed ta connect to your target without

double-checkine against real processar,
Connection information
Backend zettings Item
Backend: |wobrpe | Processor: |BHTIE0 | [setect. | Q12DCCPU-V ‘ Q24DHCCPU-V
Tareet name /1P address: 19216833 v Port: :l Backend wdbrpc
Processor SH7780 | Z5xx
192.168.3.3(default)
Kernel image
) File path from tarest {f available) IP Address (If the default IP address of the C Controller module
@ Fil:  [CAMELSECACOPLL D Tonls! 0 2DCCF -V 12052-B v | [Bramse. . has been changed, set the IP address acquired.)

[1Bypass checksum comparizan

Advanced tareet server options
[¥]erbose target server output

Options: |~R Gi/user/ WS /b3 2/cwm_HonTo ~RW ~Bt 3 -& v

Gommand Line:

tetsvr — -R Cfuzer/ WS/ wh3.2/cvw_HowTo -RW -Bt 3 —c GAMELSEG, GGPLY DV Toolsh @1 2DGCPL-
W12052-B -4 19216833

® [ < Back ][ et > H Finish ” Cancel ]

Select the "File" radio button in "Kernel image" and click
Look i [ 5 Todls v Q¥ @ the  Brawsz=.. | button.

=) 012DCCP L

tdy Recent
Docurnents

Select the VxWorks image file and click the

My Documrts button.

Click the [ Einizh button to start connecting

a! The VxWorks image file specified here should be the ©
My Comper same file as that of the C Controller module. ®
- Acquire the VxWorks image file from Q24DHCCPU-V %
Qg File name: |@1zDCCPUY 120528 v [oeen | @
MyNotwok | Flesolype: |2 8 [ using FTP. (;(_=" Page 76, Section 9.1.1) )
e

%)

(]

3

o}

with the C Controller module.

<

Completed

uoIj0BuUU0? JIBAIBS 166121 189S O)MOH Z°'L'6

79



9.2 Starting and connecting the target server

After setting the target server, select the added target server on the "Remote Systems" window. Connection and

disconnection can be executed for the C Controller module by clicking the "Connect"( H ) or
"Disconnect"( .;:T )button.

EI Below is an example of the window when "VxWorks6x_192.168.3.3 (Wind River VxWorks 6.4)" is selected.

_EﬁFlemu:ute Systems B3 = O
LR & @ B|5 7
E’ Local

e {ifind Rive

: 0% unconnected | Wind River Wiorks 6.4

Or select the added target server with the mouse and right-click. Select "Connect" or "Disconnect" from the menu.
Under "Connect", "connected - target server running" is displayed at the bottom of the main window after the target
server is started and connected.

Under "Disconnect”, "unconnected" is displayed at the bottom of the main window after the target server is
disconnected.

H Remote Systems 52 =B

S A &] 2| Bls "

Ef Local A
=581 tifind Rive
-5 Debugeer Uifind River Wil

=% \dlorks 64SHTTE0 [stateless] (SHT7A0
@ FKernel Tasks
@ Feal Time Processes
I ECMPLout:5 - Svmbal file: ASYSTE
T ECPCOoutlxd - Symbal file: ASYSTE
I EZSocketCGPPForMDoutlx? - Symbo
3 ftpdLiboutl:d - Symbal file: /SYSTE
| Q‘IEDOIlSF‘U—\.-‘_‘I 2052-B0:x1 - Symbo %
>

[

FL | connected - target server running | Kernel im.

Point/’

Once the target server is started, the C Controller module is automatically reconnected to the target server after the module
is normally started even if the power supply of the module is turned off and on.

To disconnect the target server, select the connected target server on the "Remote Systems" window and click the
"Disconnect" button.
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E Remote Systems 53 = 0O
i o B & ] 2 B|s 7
E—f Local ~

=ia] i ind Riv I3
= .'f-'i- Wind River Target Debugger WWind River W
=% Wiworks BASHTTED [ztateless] (SHTTE0
B Kernel Tasks
@ Real Time Proceszes
5 ECMPLowt0:E - Symbol file: A5vSTE
T EGPCOoutDxd - Symbal file: ASYSTE
5 EFSocketCPPForMDoutlx? - Symbo
5 ftpdLibout0x8 - Swmbol file: ASYSTE

5 12DCCPU-Y 12052-B0x1 - Svmbo ¥
| >

.|A

connected - target server running | Kernel im

The indication of the "Connect" and "Disconnect" buttons switches between enabled and disabled, depending on the status
of connection to the C Controller module.

During disconnection: "Connect"( H ) for enabled and "Disconnect"( ,;'%T )for disabled

During connection: "Connect"( H ) for disabled and "Disconnect"( .;"~T )for enabled

Point/’

The following error message appears if the C Controller module is not running or if the network is not connected while the
target server is under "Connect".

% Failed to Connect to Tareet h—(|

Failed to launch tareet server for connection "WxWorkstx_192168.3.3'
{Registry localhast).

Pozsible causs:
Back-end not connected.

Removed dead entry from Registry!

@

If the error shown above occurs, check the following:
» The C Controller module is powered on and is running properly.

+ The target server is connected to the C Controller module. (_=  Page 77, Section 9.1.1 (3))

After the target server is started and connected, select the connected target server to use the Host Shell.
For how to start the shell, refer to the following section.

[ 5 Page 83, Section 10.2
For details on Shell, refer to the following document by selecting [Help] in the menu bar &> [Help Contents] > "Wind River
Documentation" &> "Guides" o> "Host Tools" &> "Wind River Workbench Host Shell User's Guide, 3.2".
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9.3 How to Check and Change Connection Settings

If the target server cannot be connected to the C Controller module, follow the instructions below to check and change
the connection setting.

1. Select the target server on the "Remote Systems"
_Hﬁ Femc

Fotrosh ] and right-click to open the pop-up menu. Select
ties...
=J’E | resh Proper

4 [Properties].
Alt+Enter

% Tareet Connection @

Target Server Options

Feview and customize the target zerver options.

Mame |iorkatic 19216833 | Shared: []

Azsociated target platform: |Wind River WiWorks 6.4 v |

Tareet Server Options | Object Path Mappings | Target State Refresh | Debug Options

Backend settings

2. » | Backend: [wdbrpc Iv |Processor: EH??SD | [ Select.. ]l(—— 3_
4 P | Tarest name 4 IP address:  |192162.23 v Port: l:l

Kernel image

() File path from targst (f available
5 ——Pl@ File: |O:\MELSEO'\OOPU\D\.-‘x\TooIs\Q12DOOPU—V_12052—8 v|[ Browse... ]l

[ Bypass checksum comparizon

Advanced target zerver optionz
[¥]wetanze target server output

Options: [-R Gu/MELSECCWM/Work Space./CW Work bench ~RW -Bt 3 —A ~|

Command Line:

tetavr = -R G/ MELSEG/ TN Wark Space/ Tt Warkbench —RiW -Bt 3 ¢
Gy MELSECH CGPUN Dt Toolsh G 2DCCPLU-Y 120582-B -4 19216833

l@:' I Ok ] [ Gancel

2. Check the Backend field.
Enter "wdbrpc" for "Backend".
3. Check the Processor field.
Set "SH7780" (for Q12DCCPU-V) or "Z5xx" (for Q24DHCCPU-V) for "Processor".

4. Check the IP address of the target device (C Controller module).

Set the IP address of the C Controller module for "Target name/IP address".
The default IP address is 192.168.3.3.

5. Check the Kernel image.
Set the correct VxWorks image file.((_ s Page 76, Section 9.1.1)

Do not change the "Advanced target server options" setting. (The default value is recommended.)
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CHAPTER 10How TO DEBUG PROGRAM

1 01 How to Connect CW Workbench to the C Controller
Module

« Set the target server.(_ = Page 75, Section 9.1)
« Start and connect the target server.(_= Page 80, Section 9.2)

10.2 Starting Shell

On the "Remote Systems" window, select the target server connected to the C Controller module where the shell is
started. In the menu that pops up by right-clicking, select [Target Tools] => [Host Shell] to start the shell.

I WERTUR

bm LzerProj WTH Conzale

WTH Conzale Properties

<
= L=¢ Disconnect "WxWorksfix 19216833 Fun Debugger WTH Connection Test
5 Remote Syst
Refrezh Properties.. -
4 Hozt Shell Properties
E_f Local roperties Alt+Enter T >

g Fve

=8

1. Click the button.
A Start Host Shell (VxWorks6ix 192.168.3. 3@ meiw0228) %X

(D) Please sclect the command line aptions and press OK to start
the host shell

Options:
[0 ot read home Tel initialization file Enk

[ Executs Tel exprassion after intialization b

[indizate mode to start sither G{TellGdb Gl . b

[15et event poll interval (meec) [default=200] {-p

[startup file of shell commands to exscuts &)

Other Options:

[Z] Shows this dialog before host shell starts

2. Shell starts.

SINPOIA] JBI[ONUOD D BU} O} YUOUSGHIOAM AD 198ULOD 0} MOH |01

Completed
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10.3 Downloading Module

Follow the instructions below to download a module file on the C Controller module.
The module is used for an application, such as to download a file on the memory on the C Controller module and start

a task from the shell.

J{ﬁ Remote Systems &2 = O
S 2 @ B|l5s ¥
E" Local

0 ifind Five )
Wird River Target Debugeer (ind River Weliorks 640
2% wWiWarks BASHTE0 [stateless] (SHTTEO)
& Kernel Tasks

=98
=]

- T P B, OV T,
% Basic Device Development - - GW Workbench

File Edit Source FRefactor Mavigate Search  Project Bun Window Help
il m i%-0- - E Y e e e
[ Project Explorer &3 o % 2 og@- T T O @ Getting Startec
&m EntryWDTIht Oiind River Wiwiorks 64 Downloadable Kernel Module Project)
&m TestProj tifind River WiWorks 6.4 Downloadable Kernel Module Project)
= E:M UserProject tWind River WWorks 64 Downloadable Kernel Module Project!
] Build Targsts (SH7750snule)
(s Wind River Launches
=44, Binaries
UszerProject partiallmageo - [shele] (SHITE0enuls)
UserPraject partiallmage.n - [shile] (SHT7E0enule - debugl
[@h UserProjectout - [shile] (SH7750erule)
t

Lt
|@] Ihchudes Hew
(7= SH¥750erule

@ Sample.c Open
Cipen With »

1= Copy Ctrl+G
3 Delete Delete
Rename F2
Move
Attributes ¥

g Import..
3 Export..

Cipen Wind River Woilarks 6.4 Development Shell

** Build Project

& Rebuild Project
Build Options

&' Refresh F5

2 Bun Vihorks Kernel Task
Fi5 Debug Witilorks Kernel Task

Crl+Shift+A

A%
18 Remote Systems 53
'

Downlog

Ef Local

<~

To the next page
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On the "Remote Systems" window, select the target

server where the module file is downloaded.
Select the target server connected to the C Controller
module for the target server.

On the "Project Explorer" window, select the
modaule file to be downloaded. In the menu that
pops up by right-clicking, select [Download
VxWorks Kernel Task].

"UserProject.out" has been selected for the module file

here as an example.



CHAPTER 10 HOW TO DEBUG PROGRAM

3. click the button.

Create, manage, and run configurations @y
Select the launch context for executing the launch operations. @I The mod u |e fl Ie n UserP I"OJeCt,OUt" Selected In the Step 2
C@x|e k- Name: [naEniryPoint - UserProjestout - ViWarkstx 1021 68:38 ] has been downloaded on the C Controller modu|e,
¥ Launch Gontext Downloads | ** Projects to Build| ~] Gommon . . . . .
= o et ] vworks Kermal Task Dowrload Options which is a destination of the target server selected in the
Launch Context: PN R =R Step 1
[ G def '
@ig|
e The following window appears on and after the second
operation.
Select "Launch the selected launch configuration" and
click the ak button.
< I 2 % Launch Gonfiguration Selection
Filter matched 2 of 2 items.
@) Choose Action

(i) Warkbench has found one or mare existing launch
configurations that match your gelection. What do vou want 1o
do®

() Launch the selected launch configuration

() Edit the selected launch configuration

() Edit a duplicate of the selected launch configuration

() Create a new launch configuration

Matching "WxWorks Kernel Task' Launch Configurations:
noEntry Fant t -

See Tarzet Manazement/Launch Configurations for additional settines.

@ [ [0]:4 ] [ Cancel

1S4

Completed
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10.4 Howto Debug Program

This section explains how to debug a program by using a sample program (EntryWDTInt.c) of the C Controller module
as an example.

(1) Note:

The executing module needs to be built in "Debug Mode" when a project is debugged on CW Workbench.

Y output task
Task name: SmpTask_2
Function name: YWord_WriteRtnTask()

WDT main processing Task start

EntryWDTMain()

b 4

10.4.1 Debugging one task

Connect the C Controller module to CW Workbench.

For details,(_ 5 Page 75, Section 9.1,Page 80,
Section 9.2).

1. Onthe "Project Explorer" window, select a project
% Device Debue — UserProjectfSample.c - GCW Workbenc
to be debugged. Click the ¥ mark on the right side

File  Edit Source Refactor Mavieate Search  Project  Target

- = - Q-Qc | W of a debug icon( iﬁ; ) on the toolbar and select
. JLLL I ] DY

B [Debug Configurations...] from the pop-up menu.

E“\:, Froject Explorer (7 % Debue

Debug As
Debue Confieurationz...
Creanize Favorites..

BN E vt WD TInt (ifind River Wt

= &-H zerProject (ifind River Wi .

gt Build Tareets (SHT7E0nule - debue?
iz Wind River Launches

w2 Rinariae

To the next page
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2. Double-click "VxWorks Kernel Task" to create a new
% Debue Confieurations debug configuration.

Create, manage, and run configurations

£ e H .
L] L S Configure launch sett
| | .j - Press the 'Mew
{3 pttach Target Gontext = - Press the 'Dupl

[T ] GAC++ Application
[E] GAG++ Attach to Applicati | 96 — Press the ‘Dele
[T ] AT+ Postmortem Debue
[T ] G/T++ Remote Applicatior
7 Launch Control - Edit or view an
el T.

Wiiorks Feal Time Proce:

—+ e
v — Press the Filte

&

Configure launch pers

3. Check that the target server connected to the C

Create, manage, and run configurations
@ Mo o it e P - Controller module to be debugged has been
< @ -
uEex Ead MName: [noEntryPaint - TestProjout - VxWorkstix 19216833 | seIeCted' CIICK the B TOWEE. .. bUtton'
I—‘ 8 Launch Gontext 5] Downloads| 2 Projects to Build| % Source | £ Gomman
£ Attach Target Context
[E] G/G++ Application VWxWorks Kernel Task Options
[€] G/G++ Attach to Applicat = =
[] C/C++ Postmortem Debu Launch Gontext: £l B8 O O
[€] G/G++ Remote Applicatic — EEN N
7% Launeh Gontrol 2 [#] G default Uocalhost) .
5 G Vs Kermel Task. (297 Wlorkstix 19216833 Wind River Vsiblorks 6.4) T
noEntryPoint - TestP o9
@ Viciarks Real Time Proce g 2
—
o
~ General «%
o O
Eniry Point 9 | [ Browse. ] = @
3 O
Arguments: | ] «Q c
o «Q
» Advanced g -
~ Deb =
chug - O
Erreak on Entry Q0 Q
w =
[[] Automatically attach spanned Kernel Tasks = 9
« | £
Filter matched @ of @ items
@

A5

To the next page
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% Entry Points

Select Entry Point

@ Pleaze gelect an entry point

X

Pattern (7 =

aty character, * = any =tring, < = end of pattern):

Maodule entry points:

= [Eb Downloads

=- ' W ErtryW DT aut

L] StatusGhecthn
& W START TEXT
& WDThtHook Rin

& hord WhiteFtn Task

Select the launch cantext for executin the launch operations.

CEx B3

Mame: [EntryWDTMain — EntryWDTint out - sborksfix 19216833

[tvme fitter text

89 Attach Tareet Context

JE] G/Gr+ Application

[£] G/C++ Attach to Application
€] G/Gr+ Postmortem Debueeer
[£] G/C++ Remote Application

1 Launch Cantext

[ Downlaads | #%

Projects o Build | & Source | £ Gamman|

VxWorks Kernel Task Options

Launch Gontext

7 Launch Gontrol
=2 Gp Vicorks Kermel Task
Gy nontryPoint - EntryWDT)
© C \iclorks Real Time Process

= [ @ default localhost)

[71HE ViWorks6x 19216833 Qhind River Veoorks 6.4)

~ General
Entry Point [EntryWDTMain ]
Arguments: [ |
» Advanced
~ Debue
Break on Entry
[VAitamatically atfach spanned Kemnel Tasks:
s ] 3
Filter matched 9 of O items.
®

Point/’

4. select the function (Entry Point) where debugging

starts. Click the k. | button.

[ Ok ] [ Gaticel
m O Check that the function name selected in the step 4
Create, manage, and run configurations

has been selected for "Entry Point:"

Click the button.

To debug a task created (taskSpawn) from the function specified in "Entry Point:", "Automatically attach spawned Kernel
Tasks" at the bottom middle of the dialog box also needs to be selected.

88
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6. At first, debugging starts at the beginning of the

EnbryWDTInEc 50

/* ¥ putput task ks = T " AT

Coa THord WriteRtnTask () function specified for "Entry Point:" in the Suspend
status.

llf*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t/

A WDT Main processing L

void EntryWbDTMain () | <« The function specified for "Entry Point:"

short ret;

* Start the wmodinle Lol Imonitor task
ret = taskSpawvn (TASK NAME 1, |
PRJ.URJ.X‘[il o,

<« The location being suspended is highlighted in green.

o, . .. .
STACE, The display is in the same form as that of when a task is
(FUNCPTER) 3tatusCheckRon, . . .
0.0, 0,0, 0 0 0 0,0, 0 suspended at a breakpoint described in the step 9.
if {rec == ERRCR]{
printf ["StatusCheckRtn task start error ret = $hd [ hxH )4
return;
}
/* Start ¥ output task Ly

ret = taskSpawmn (TASE NAME 2,
PRICRITY_160,
o,
STACE,
(FUMCPTR) YWord WriteRcnTask,
o, 0, o0, 0,0 0,000 0

if [ret == ERROR]{

Y — 7. Insertthe breakpoint to a place where a task

operation needs to be suspended.

return;
j
R R R AT R AT ARTEATARTEATARTEAARTEAARTE AT AR Adding the breakpoint displays breakpoint information
/* HModule status monitor processing = . " . .
/"tﬁ‘%‘wﬁttﬁ‘twﬁttﬁ‘twtt*ﬁ‘tﬁtﬁﬁﬁ‘ﬁ‘ﬁ1“1“1“%‘ﬁ‘ﬁ***ﬁtﬁ***ﬁtﬁ**ﬁﬁwﬁ*ﬁ*ﬁx Inserted On the Breakp0|nt Wlndow.
id StatusCheckRt . s .
e atuscheckRtn) Clearing the check box of the breakpoint information on
;::;t ;:gh the "Breakpoints" window disables the breakpoint being
long  plInfo[l5]: inserted without canceling the breakpoint. =2
long event [4] ; o o
unsigned long ulBufsize; ’ = B
@ Breakpoints 537 8 s
o
/% Execute QBF_Open i w \Q\ L] = g =
@ ® | = -
ret = QBF Open(UNIT, &path): : & . v 23
if (ret != 0){ @ /TestProj/EntryWDThtc:81 #Planted® Restricted Scope) Q g
printf ("QEF Cpen error ret = %$hd | %$hxH )'\n", ret, ret); Q. )
_ 3 o
return; Q c
)
} % o
58
@.............Q.l..............Q.l................'...... %a
3

To add a breakpoint, double-click on the left edge of the edit window, at the line where the breakpoint is to be set.
The breakpoint can be removed by a double click once more.
© 0 0 0000000000000 0000000000000 0000000000 000000000000000000000000

<

To the next page
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=g

=

UB‘ l‘if [ -lf‘i E 14> '@4}
= q.,} ErtryWDTMain - EntryWDTIntout - Waorkstx 19216833 [k
= sys—000 (Tazk Mode)
=8 tEntry'WDTMain : 0x49382FBC (Stopped)
=" EntryWDTMain® — Entry'WDTInt.c:d3
=" vxTaskEntry( - 0x480406aa
g tERtryWDTMain : 0xd9382FBC

i& Debug 23

| #
|

<~

€| EntrywWDTInk.c 53

/% Module status monitor processing
ll."ﬁﬁﬁﬁﬁﬁﬁ‘ﬁ‘ﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ‘ﬁ‘ﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ
vroid StatusCheckRtn )
{

short ret;

long path;

long plInfo[l5]:

long event[4] ;

unsigned long ulBuf3ize;

;% Execute QEF Open

ret = (QBF Open (UWIT, &path):

if (ret 1= 004
printf ("QEF_Open error ret = 3hd [ $hxH 1hnt,
return;

'

%5 Debug 53
=

O ] B & 2D g = i &

= % ErtriWDTMain - EntryWDTInbout — WeWiorksf: 192168.3.5 [
= sye-000 (Task Made)
=& SmpTaszk 1 : 0x49CE3074 (Stopped — Breakpoint Hit)

@ SmpTaszk 2 : (x4FFFGFEC {Running?
@ <terminated, exit value: 285245t EntryWD TMain : 040382 F B

| #
hd

2V

To the next page
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8.

Click the ( [[E=) button to restart the task operation.

How to see the status of the task operation
The following table lists how to see the status of the task
operation based on enabled or disabled status of the

three buttons: Resume ( [If=), Suspend ( [|[] ), and

Terminate ( [&] ).

Button status Task operation status
Suspended status (during suspension)
No.1 Click the [][# button — turns to the status of No.2.
O ]
Click the [M button — turns to the status of No.3.
Resume status (during execution)
No.2 Click the ||| button — turns to the status of No.1.
g IE
Click the [M| button — turns to the status of No.3.
No.3
Termination status (debugging terminated)

9. The task operation goes into the Suspended status

at the point where the breakpoint was inserted in
the step 7, and the operation has stopped.

Continue debugging by operations such as checking
variables with step through execution and changing
variables.

10. use the following step execution buttons on the tool
button on the "Debug" window to continue
debugging.

Icon Description

Step Into
Steps into the called function and stops at the first line
of the function.

Step Over
Executes the current line of the function and then
stops at the next line of the function.

L]

Step Return
Continues execution until the current function has
returned to its caller.

-




()= Variableg 23 11 Registers | &9 Expressions ﬂ Memory Browser

B | [(f& & 7
MHame Type Value
()= ret shart int -1
()= path lone int 1228250268

B i pllhfo | lone int[15]

= = event  long int[4] 0x49339F B

()= evel long int —-286331154
()= evel long int -286331154
()= ever long int —-286331154
(9= evel loneg int -286331154

()= ulBuf5i; lone unziene. O<EEEEEEEE

MName : plInfo
Binarv:0b01001001001110001001111110000000

| [

6= Variahles | 1) Registers £3 . 69" Expressions | [J Memory Browser | = O
HEE G &7

Hame Walue Dezcription i
2 &% General General
piag rQ 00000000 L
| il | [x49380FEC ]
biai 12 OxdJ382F BC
pig 13 Oxd936EF G4
Biai rd 40000000
Bt v [xd82D2B3C
M rE 00000096 X
< @
Mame : rl )
Einary:0b010010010011100000101111111031100
Decimal: 12258419052 B
Hex:0x49382FEC bt
()= Variables | 1% Reeisters | & Expressions 53 [ Memory Browser =0
LY TR N
Expression Type Walue MName : path
Binary:0k01001
long int[4]  Ox49389FBG Decimal:122822
9= evertll]  lone int -286331154 Hex:0x4935BFC4
9= evert[1]  long int —286931154 Default:122582E
9= event[2]  lone int -205331154 QOorali01111533
9= eventla]  lone int -286331154 String:
Adef mew axpr
£ >
6= Variables | 11} Regizters |89 Expressions | [J Memory Browser 53 =08
=Y
[0xEGODO000 | [Ga] [New Tat ]
OxECOO0000 F5
OxECO00000 OO000000 0000000 =Va. .. ... ... "~
OxECOO000O0C 00000000 00000000 00000000 . ... ..o e e un
OxECOO0001S5 00000000 00000000 00000000 .. ... ..o e e un
OxECOO000Z4 00000000 00000000 a0000000 .. ... .o v e un
OxECOO00030 00000000 00000000 00000000 .. ... .. eeun B
OxECOO0003C 00000000 00000000 a0000000 .. ... v e un 2

1S4

To the next page
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= 11. Clicking the <<Variables>>,

<<Registers>>,<<Expressions>>, and <<Memory
Browser>> tabs during suspension of tasks
displays each window. Checking and changing
values allows efficient debugging.

"Variables"
Displays the current values of local variables.
"Registers"
Displays the current values of registers.
"Expressions"
Displays the current values of variables in the
Watches window.
"Memory Browser"
Displays the memory dumps on the C Controller
module.

The color of cell changes to yellow when the value has
changed from the previous value by step through
execution or when the value has been changed.

On "Memory Browser", the color of cell does not
change, but the color of font changes to green.

On "Memory Browser", timing to refresh values can be
selected unlike other windows.

Right-click on the "Memory Browser" window. Select
[Update Mode] from the pop up menu.

Always update

arE Radix ¥ Browser 53 =0
Cioluming 4 £5 E
Lpdate : ® flways u

] On Breakpoint

00 Man‘ual

(nln Copy fddrezz 7 | Lo ... ”

(] Feset To Baze Address | oL .. .. ...

ac =T T

IS = Taln] nnnnnny( [ainlnininininlnl

Update during suspension Manual update (Refresh)

witl

h a breakpoint inserted

91

yse} auo buibbngeg Lv°0l
weJsbold Bngag 0} MOH 0L




/* Register cimer svent of 500ms cycle. . 12. Placing the mouse over a variable for a certain

Pad0] = 1; /7 Timer event count i

F— Tope Value w period of time displays the current value of the
B (& event lone intl2] 0:x49989F G 4 i .
s lorg int 286231154 =1 variable in a balloon.
lang int 1} . .
_ long int ~208331154 The value displayed in the balloon can be also
* (9= event[3] Iong int -286331154 i . )
= rEsl changed like on the "Variables" window.
y
/% Register a routine for the user WDT error interrupt. L7

ret = (BF EntryWDTInt (path, 0, (FUNCPTR]WDTIntHookRtn):

rﬁ.‘?« Debue 53 = O

-, 13. Click the Terminate ( [® ) button on the "Debug"

window to terminate the debugging session.

% B 5 O R

U =N Gl

= % EntryWDTMain - TestProjout — Waifork
=8 SHTAN (Tazk hade)

<~

Completed

Point />

To debug the task again, click the W mark on the right side of the debugging icon ( ﬁ ) on the toolbar and select the

created debug configurations at the top of the pop-up menu.
The steps 1 to 5 can be skipped.

& Device Debue — EntryWDTInt EntryWDTInt.c — W Workbench

File Edit Source Refactor Mavieate Search  Project  Target  Bun Window  Help
Nzl wily w8 -0 | F- I HSBdy- (T A6
[ Project Explorer 52 1 EntryWDTMain — EntryWDTIntout -

Debug Az 3

Debue Configurations...

EntryWDTInt Giind River Wi

& Entry'WDTInt_partiallmage. Organize Favorites.. ;:
CE- [ EntryWDTntout SSHY7E0emmerremmer il 1
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CHAPTER 10 HOW TO DEBUG PROGRAM

10.4.2 Debugging multiple tasks

(1) To debug multiple tasks, execute steps 1 to 5 in "Section 10.4.1. Debugging
one task" as many times as the number of tasks to be started.

(2) The "Debug™ window displays the executed tasks.

El An example of when two tasks have been started

| EntryWDTnto 53 = O | % Debue i3 =0
return; % e ] @M 2RRBE B &7
¥ (= (& EntrtDTMain - EraryWDTTvt.out - Viark st 19216033 Dixtilorks Kernel 1)

2@ SHI7E0 (Task Mode?

SRR R R E R AR AR AR E AR AR R E AR AR TARE AR AR R AR AT AT & @Jj tErtry WD T Mair © Dx49302FBC (Stopped)
' T word output processing =" EntryWDTMain® - EntryWDTInt c:dd
jrEraEs =" vxTaskEntry () - 0x480495aa

CE R R
proid (o tEntryiWDTMain - 0x49382FEC J
(= % Wilord Wik iteRtnTask - EntryWDTIntout - WiWiorksfix 19216333 [Wiiorks Ke))

i

short ret; =¥ SHIT80 (Task Mode?
long path: =@y tYWord WiriteRinTask. : (x4FFFSEA0 (Stopped - Breakpoint Hit)
unsigned short data[1]: Task 2 = R
wxTaskEntry - 0x430406aa 4
/% Execute OFF_Open */ W ¥Wiord Wite FanTask : 04 FFFSESD
ret = OBF_Open(UNIT, &path);
if(rec '= 0){

printf ("QBF_Open error ret = %hd { $hxH )\n", ret, ret);

return; The task 2 function is in the Current
4 status.
e The source code in the left dialog
/%  TIncrement YO - ¥F every ome second *f box shows the breakpoint_

R AR AR AR AT AT AT AT AR TR AR R AR R AR R A AR AR

data[0] = 07

whileil){
J*  Write YO - YF walue "7
ret = (BF_Y Out WordExipath, 0, 0, 1, data, 0):
if(ret != 0)4{
printf ("QBF_Y_Out_WordEx error ret = %hd ( $hxH 1hWn", ret, r
break: < | >
S5
. NN
(3) To debug another task, use the mouse to select another function on the N
. o9
"Debug" window. gz
- - - - <Q
Switch tasks while multiple tasks are being debugged. < g
Q c
An example of when switching from the task 2 to task 1 3 ‘E’U
s
]
€] EntryWDTInte 53 = B %% Debug i3 =8 g3
% e R A i & 7 2
/7 sutput task M4 (= T EntryWDTMain - EntryDTIntout - aslWarkstix 19216623 [viWorks Kernel Task] @
roid YWord WriteRtnTask(): =] SHTTS0 (Task Mode)

= @ EntryWOTMain : 0x48382FBC (Stopped!
—

=" wxTaskEntry(
BEEEEEEEEEEEEEEE R TR A A AL :
| tEntrWDTMain : 0x49382F BG

= U Yibord WriteRinTask — EntryWDTIntout - Vidbark st 19216833 [Viiorks Kernel

= &% SHTTE0 (Task Mode)

short  ret; =@y trord_WriteRinTask - 0x4FFFSEA0|(Stopped - Ereakpoint Hit!
- — =' iblord WriteFitnTask O - Ertry WD Tvtc187
/* Srart the wodule status monito # 51 wxTaskEntry @ - (48040683
rec = EaskSpswn (TASK_NANE 1, o] tWord W iteRinTask : 0x4FFFSESD
PRIORITY 150, * /
o,
STACE,
[FUNCPTR) StatusCheckRtn, The task 1 function is in the Current
) d, o, o, 0, 0, 0o, 0, 0, 4, O0): Status.
if [ret == ERROR){ L
printf ("StatusCheckRtn task start error ret = $hd [ $hxH The SeIECted fUnCthn IS now
. return; 1 displayed.
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10.5 How to Execute Dynamic Printf

This section explains how to execute Dynamic Printf.

Dynamic Printf is a function to dynamically insert or cancel the printf statement when debugging the program without
embedding the printf function to the source code with the similar operation as that of the breakpoint.

Dynamic Printf is only compatible with Q24DHCCPU-V.

J@ AtomTestProcpp 5

short mdTest (void) {
long path = 0O:
Toeele Breakpoint ]

¢ fdd Dyvnamic ‘printf'.

Breakpointz 3
Tracepoints 4

Add Book mark...
Add Taszk .

v Show Quick Dift
Show Annotation
Show Ling Mumbers
Falding 3

City [+ishift+Gl

Preferences..

2V

® Dynamic 'printf' Properties

Dynamic "printf' Location and Arguments frj

Select debug target for target-specific information

None — preserve current ssttings

Gereral | Source Lookup Status Scope Advanced
Path Type @ Project System O File System
Fils Path B, [/ATOMTest/AtomTestPro.cpp

Line 208 |

Printf (. |*path=td" path |
Enabled
[verbose Made

[Ccondition | ]
[Cskip Count | |
@

<

To the next page
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1.

On the "Editor" window, open the source file which

is a target for debugging, and right-click the left
edge section

to open the pop-up menu.
Select [Add Dynamic 'printf'...] from the pop-up
menu.

The "Dynamic 'printf’ Properties" dialog box
appears.

Enter the printf statement to be displayed when
debugging the program for "Printf (...)" with the
same text format as the argument to be written in

the printf function, and click the button.



CHAPTER 10 HOW TO DEBUG PROGRAM

3. The printf statement entered for "Printf (...)" is

8 Breakpoints 53 =0 . .
© SrestpaE added on the "Breakpoints" window.

RRP | BEE T

BB printfl" path=%d" path) /ATOMTeszt/ ftomTestProcpp 208
The execution result is displayed on the "Console"

window.

=> To display the result of Dynamic Printf on the "Console"

Create, manage, and run configurations ﬁ window, select "Allocate Console (necessary for input)"
——— on the <<Common>> tab of the "Debug Configurations"

U & B - Name: [mdTest - 024DHCGPU-V_SHout - G24DHCCPU-V sh

bretieet )N g e ot [ borioed [S% rocs o B 5 Souee [E3Gomnan dialog box.

=48 Attach Tareet Context

53

B
£ Q24 DHCCPU-V.SH_HIF a‘f ES‘ .
183 024DHOCPU-V SH_HO7 1) Ollzsily
[E] C/G++ Application O Shared file: | ]
[E] G/G++ Attach to Application
[E] G/Ge+ Postortem Debusesr Display in favarites menu Gonsole Encoding
[E] C/G#+ Remote Application [ %5 Debug © Default - inkerited (M5532)
% Launch Gontrol O Oother
=G Vidorks Kernel Task [ % Download
O mdTest - QZLDHCCPU-Y SHou
@ Vilhorks Real Tine Frocess Standard Input and Output
V] Bllocaie Cansale Gecessary Tor hput)
[IFie: |

syse) sjdninw Buibbngaq Z'+'0lL
Juud o1weuAq aindoax3 0} MOH G0l
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CHAPTER 11 TROUBLESHOOTING

The following table lists errors that occur during use of CW Workbench and their solutions.

Category

Problem

Reference

Basic operation

The CW Workbench installer has stopped working half way through. Or the installer has
terminated suddenly during installation.

Page 97, Section 11.1 (1)

A message "The install root of your Wind River Workbench installation could not be
located!" appears and CW Workbench cannot be started.

Page 97, Section 11.1 (2)

A message "Workspace in use or cannot be created, choose a different one." appears and
CW Workbench cannot be started.

Page 97, Section 11.1 (3)

A patch has been applied, but the display does not change.

Page 98, Section 11.1 (4)

The install menu of the plug-in software cannot be found.

Page 99, Section 11.1 (5)

You have received a permanent license file, but do not know how to use it.

Page 100, Section 11.2
M

Page 100, Section 11.2

License You do not know how to delete a permanent license file. )
An error message with a title of "License Not Found" appears when CW Workbench is Page 100, Section 11.2

started or being operated. 3)
Page 101, Section 11.3

An error "command not found" has occurred and the build is not executed. 9 ™)
. ) ) ) . Page 102, Section 11.3

An error "no input files", "No Such file", or "No such file or directory" has occurred. )
An error "Build target "/yyyy/nnnn_partiallmage" used in build target "yyyy" not found" has Page 102, Section 11.3

occurred and the build is not executed. 3)

Building The following build errors have occurred:

"xxx.sh: syntax error near unexpected token "yyy_partiallmage/Debug/Objects/nnn™
"xxx.sh: cannot execute binary file"
"Makefile:xxx: *** missing separator. Stop"

"yy.o: command not found ... No such file or directory"

Page 103, Section 11.3
4)

.out file is not created.
The build terminates with a message "Generation of makefiles started."

Page 103, Section 11.3
®)

Target server

CW Workbench cannot be connected to the C Controller module.

Page 104, Section 11.4
™M

When "Connect" is executed on the "Remote Systems" window, an application error
occurs and CW Workbench cannot be connected to the C Controller module.(Failed to
Connect to Target)

Page 105, Section 11.4

connection ) (2)
The connection status of the Remote Systems suddenly changes from "Connected" to
"Disconnected".
Page 105, Section 11.4
The selected target connections are not imported. 9 3)
) Page 106, Section 11.5
.out file cannot be downloaded on the C Controller module. ™)
Downloading

.out file sometimes cannot be downloaded on the C Controller module.

Page 106, Section 11.5
(2)

Installation using
a temporary
license

After an LAC code and user information are entered and the button is

clicked, an error message appears and the installation does not progress.

Page 107, Section 11.6
M
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CHAPTER 11 TROUBLESHOOTING

11.1 Basic Operation

(1) The CW Workbench installer has stopped working half way through. Or the

installer has terminated suddenly during installation.
This problem occurs when characters other than alphanumeric characters, an underscore "_", and a hyphen "-"
have been used for the folder name of the installation location specified at first on the CW Workbench installer.
« Action
Use the following characters for the folder name of the installation location and reinstall CW Workbench:
* Alphanumeric characters
» underscore "_", hyphen "-" (Space cannot be used)

(2) A message "The install root of your Wind River Workbench installation could
not be located!" appears and CW Workbench cannot be started.

This problem occurs when characters other than alphanumeric characters, an underscore " ", and a hyphen
have been used for the folder name of the installation location on CW Workbench.

 Action
Uninstall CW Workbench. Use the following characters for the folder name of the installation location and
reinstall CW Workbench:
* Alphanumeric characters
» underscore "_", hyphen "-" (Space cannot be used)

(3) A message "Workspace in use or cannot be created, choose a different one."
appears and CW Workbench cannot be started.

This message appears if the folder of the workspace specified at first is being accessed by another CW
Workbench.
 Action
Click the k. button. Select a different folder for the Workspace folder displayed again or
terminate the CW Workbench that is operating already.

uoneladp aiseg L1

97



(4) A patch has been applied, but the display does not change.

Old data may be in the cache.
+ Action

When starting CW Workbench, specify "-clean" in the argument.
After CW Workbench has been started with "-clean" specified, delete "-clean" from the boot argument.
(Keeping "-clean" being specified slows the startup of CW Workbench.)

(a) How to specify "-clean”

Open
Run as...

Scan with Officescan Client
Pin ko Skart menu

Send To r

Cuk
Copy

Zreate Shorkcut
Delete
Renarme

Propetties

CW Workbench Properties

General | Shorteut |Eom|natihilit3,I | Security|

@ Cw/ Workbench

T arget type: Application
Target location: eclipze

Target: |rm\xBE-win32\eclipse\wrwb-xBE-winSZex -clean

Start ir: | CoivwiindRiver |

Shortcut key: |None |

Rur: | Mormal window M |

Carnmet: | |

[ Find Target... ] [ Change lcon... ] [ Advanced... ]

[ 1].4 ][ Cancel ][ Apply

98

(b) How to delete "-clean"

1. Select the CW Workbench shortcut on the desktop.
In the menu that pops up by right-clicking on the
shortcut, select [Properties].

2. Entera space at the end of "Target:" on the CW
Workbench Properties.
Enter "-clean" after the space and click the

k. button.

In the step 2 of [How to specify "-clean"], delete the space and "-clean". Click the k. button.
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(5) The install menu of the plug-in software cannot be found.
To install the plug-in software, select from the menu bar [Help]=>[Install New Software...].
If [Install New Software...] cannot be found on the Help menu, the display mode of CW Workbench is "Basic

Device Development".
Check the current display mode of CW Workbench on the title bar.

% Basic Device Development — CW Workbench

File Edit Source Refactor Mavigate Search  Project Bun Window Help

 Action
Change the display mode of CW Workbench to "Advanced Device Development".

(a) How to change the display mode

1. Select from the menu bar [Window] => [Open
m Help Perspective] => [Advanced Device Development].
) HMew Window o
Mew Editar

w

Y

Open Perspective i Advanced Device Development

1| Show View " [ Basic Device Development
: Impart Perspectives.. m Device Debug
Export Perspectives.. £l Remote System Explarer

Custamize Perspective...

Save Perspective Az. Other..
Another way to change the display mode is click the
= Open Perspective icon ( ﬁ ) at the upper right corner
. _ﬁ EEY Advanced De.. |E of CW Workbench and select "Advanced Device
= B Advanced Device Development = H

3 Basic Device Development Development" from the menu displayed.

[E Device Debue

Cither...

1S4

uoneladp aiseg L1

2. Check that the title display of CW Workbench has

% Advanced Device Development - - CW Workbench
Eile Edit Source Refactor MNavieats Search Project Target Bun  Window Help been changed to "Advanced Device Development".

<

3. Toinstall the plug-in software, select from the menu
I!!! bar [Help]=>[Install New Software...].
G5 Welcome
7 (%) Help Contents

7 Sgarch
Dvnamic Help

Kew Azzizt. Crl+Shift+L
Tipz and Tricks..
Cheat Sheets..

Check for Updates

() Getting Started
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11.2 License

(1) You have received a permanent license file, but do not know how to use it.

Store the obtained permanent license file in the license folder in the personal computer where CW Workbench
has been installed.

"5 Page 25, Section 5.3

(2) You do not know how to delete a permanent license file.
Delete all the files in the license folder in the personal computer where CW Workbench has been installed.
[ 5 Page 26, Section 5.4

(3) An error message "License Not Found" appears when CW Workbench is
started or being operated.

An error has occurred with the license file being used for CW Workbench.
[ Page 112, Appendix 2
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11.3 Building

(1) An error "command not found" has occurred and the build is not executed.

A compiler that cannot be used on CW Workbench has been selected.
« Action
From the tree view to the left on the "Properties" window on the "Project” menu, select "Build Properties" and
click the<<Build Support and Specs>>tab. (The window shown below is the one that appears when the
project name is "UserProject".)
Check that the compilers that cannot be used have not been selected for "Available and enabled build

specs:".

Since the "Available and enabled build specs:" supports only the following build specifications, clear the
check boxes other than the following build specifications.

=> For Q12DCCPU-V: "SH7750gnule"

> For Q24DHCCPU-V: "PENTIUM4gnu"

% Properties for UserProject .. E
| | Build Properties hd
Fezource . . .
Binary Parser Specify all build properties.
Build Properties @ Build Support and Specs |¢§1“ Build Tools | $ Build Macros | (= Build Paths | 24 Libraries
Builders Bwild :
G/C++ General Ml =Lppar
Froject Thfo @ Managed build  (makefiles generated by the IDE)
Project References () Disabled
Refactoring Hiztory
.?:2:?&2? Settines Build command: ¥makeprefix¥ make ——no—print-directary
“alidation
Available and enabled build specs:
[1 SH7750diab Enable All -
[] SH77E0diable =
[ 5H7750enu Dizable All w
SHITE0eENUlE o)
2
o
2
Default build spec: |8H??5Dgnule v|
Active build spec: |8H??5Dgnule v|
Debug mode
@j [ Ok ] [ Cancel ]
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(2) An error "no input files", "No Such file", or "No such file or directory" has
occurred.
The source file may not have been registered in the build project.
* Action
Create a file with extension of ".c" or ".cpp" or change the file name to the one with extension of ".c" or
".cpp". Register the file in the build project and execute the build.
[ 5 Page 55, CHAPTER 8
Follow the instruction below to change the file name.

& BasiciDavicejDevalop mentyny O¥ Woskbench « With "Sample" selected, select [Rename] from the menu that pops
up by right-clicking.

File Edit Source Refactor Mavieate Search Project Bun  Window Help

A il il e P -0~ -1 E P LR
[ Project Explorer i3 R m@&E-Y 0@
2 EntryWDTInt Uifind River Wxiorks 64 Downloadable Kerrel Module Project! * Select "Sample" and press the Il keY-

12 TestProj (Wind River WaWorks 64 Downloadable Kernel Module Project)
= tg UserProject MWind River WxiWorks 6.4 Downloadable Kernel Moduls Project)
[y Build Tareets (SH77E0enule)
g5 Wind River Launches
1‘,—? Binaries
[t Inehudes
(7= SH7a0enule

SR Sample

New 3

Open
Open With 3

B Ciopy Citrl+G

¥ Delste Dlete
Rename 2

Attributes 3

(3) An error "Build target "/yyyy/nnnn_partiallmage” used in build target "yyyy"
not found" has occurred and the build is not executed.

The file with the same name as the project name may have been renamed.
+ Action

Create a project and move the source file from the project where an error occurs.
[ Page 55, CHAPTER 8

Point/’

The following message appears when the project where an error occurs is deleted. Check if the box is selected or cleared.
Do not delete the necessary file by mistake.

® Delete Resources = Clicking the Ok button with the box cleared ([])

9 Are you sure vou want to remove project ‘Sample’ from the workspace? deletes the prOJect from the workspace. The file remains on
5 the hard disk.

Clicking the QK. button with the box selected

([+]) deletes the project from the workspace. The file is

Presview > ][ O ][ Cancel ]

deleted from the hard disk at the same time. (The deleted file
cannot be recovered.)
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(4) The following errors occur:
"xxx.sh: syntax error near unexpected token 'yyy partiallmage/Debug/Objects/
nnn""
"xxx.sh: cannot execute binary file"
"Makefile:xxx: *** missing separator. Stop"
"yy.o: command not found...No such file or directory”

The source file name may have symbolic-characters.
 Action
Remove the following symbols and characters that cannot be used from the file name with an error message

nnn and from the name of the source file added to the project.

Symbols/characters that cause a build error

# Sharp sign

Ampersand

Apostrophe

( Parenthesis

) Parenthesis

Semicolon

= Equality sign

Grave accent

Two-byte characters

Katakana

The following symbols that cannot be used for file names on Windows also cannot be used for the source
file.

Symbols that cannot be used for file names on Windows®

\ Backslash

/ Slash
Colon

* Asterisk

? Question mark

" Quote

< Less than

> Greater than
Pipe

(5) .out file is not created.
The build terminates with a message "Generation of makefiles started."

The source file name may have a dollar sign "$".
« Action
Remove "$" from the source file name.
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1.4 Target Server Connection

(1) CW Workbench cannot be connected to the C Controller module.

(a) Case 1: [Log Console] A message "Differences for module "xxxxxxx" segment's
address" appears.
The VxWorks image file of the C Controller module is not the same as that of CW Workbench.
 Action
The VxWorks image file of the C Controller module must be the same as that of CW Workbench.
[ 7 Page 75, Section 9.1

(b) Case 2: A message [Failed to Connect to Target] appears.
The C Controller module may not be connected to the CW Workbench network or the IP address setting may
be wrong.
+ Action
Check the following items:
» The C Controller module is on.
» The C Controller module is properly operating. (There is no error.)
» The LAN cable connector connecting the development environment (personal computer) to the C
Controller module has been fully inserted into the LAN socket.
» LEDs of all the LAN ports to which LAN cables are connected are lit.

« IP addresses of the development environment (personal computer) and the C Controller module have
been set properly.

Point/’

If the problem is not solved by applying the corrective actions shown above, delete the cache folder and restart CW Workbench.
(It may take time to startup at the first time after deleting the cache folder.)
@® Cache folder
"C:\Documents and Settings\User name\.workbench-3.2.x. xxxxxxxx-xxxx"
User name: The user name currently logged on
x: A value added automatically

(c) Other causes

The host name of the development environment (personal computer) where CW Workbench has been installed

may have only one character or more than 15 characters or may have two-byte characters or one-byte
katakana.

» Action

Set the host name of the development environment (personal computer) within 2 to 15 alphanumeric
characters.
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(2) When "Connect" is executed on the "Remote Systems" window, an error
occurs and CW Workbench fails to be connected to the C Controller
module.(Failed to Connect to Target)

The connection status of the Remote Systems suddenly changes from

"Connected" to "Disconnected".

This error occurs when: "Connect" has been executed on the "Remote Systems" window of CW Workbench on
multiple personal computers for one C Controller module, or "Connect" has been executed on the "Remote
Systems" window of CW Workbench multiple times on one personal computer for one C Controller module.

 Action
Do not execute "Connect" on multiple personal computers to one C Controller module at the same time.

Do not execute "Connect" on the Remote Systems window of CW Workbench multiple times to one C

Controller module.

(3) The selected target connections are not imported.
This error occurs when: the multiple target connections are selected, and the import operation is executed.

 Action
Import the target connections one by one which are not imported.

uono8uUU0) JBAISS 186ie] 1|
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11.5 Downloading

(1) .out file cannot be downloaded on the C Controller module.

[Problem Occurred] message
Possible Cause:
Download failed.
The path or the file name of the .out file to be downloaded has characters or symbols that cannot be used.
+ Action
Remove the following symbols and characters from the path or the file name of the .out file to be
downloaded. Select the file again and download it.

Downloading fails if an .out file has the following symbols/characters for the path and the file name:

' Apostrophe

* Asterisk
Colon
Semicolon
Period

< Less than

> Greater than

/ Slash

? Question mark

Space

Two-byte characters

Katakana

(2) .out file sometimes cannot be downloaded on the C Controller module.
The path of the VxWorks image file selected for the target server setting may have two-byte characters or
katakana.

+ Action
Remove two-byte characters and katakana from the path of the VxWorks image file.

[C 5 Page 75, Section 9.1
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11.6 Installation using a temporary license

(1) After an LAC code and user information are entered and the [ pext > |

button is clicked, an error message appears and the installation does not
progress.

Error message

& Error Message &l
Errors occurred while trying to werify the entered Licenze Authorization
Code (LAY

¢ Action

The following table describes how to respond to the error text displayed in the "Error Message" dialog box.

Error text Action

The HTTP server you are trying to access may not be responding properly.
HTTP Server: Bad Gateway Try to install the product later.
If the problem still remains, try to install the product another day.

The personal computer in use may be connected to the Internet via a proxy server.

Unknown Host: Use the button and go back to the "Installer-Online Update

Settings" window. Check the box of "Connect to internet using proxy server" and
configure the proxy server setting.

The personal computer in use may not be connected to the Internet.

Check that the personal computer can be connected to the Internet.

Unable to read repository at Install the product on the personal computer being connected to the Internet.

When the personal computer is connected via a proxy server, conduct the measure of
the error text (Unknown Host) above.
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APPENDIX

Appendix 1 Installation and Uninstallation of the Plug-in
Software

This section explains how to install and uninstall the plug-in software, an extended function of the product.

For details on the plug-in software functions, refer to the following Wind River Workbench document provided by Wind River
Systems, Inc.

O Click the menu bar [Help] => [Help Contents] => "Wind River Partners Documentation" — "Eclipse

Workbench User Guide" — "Tasks" — "Updating and installing software"

Appendix 1.1 Installation

Follow the instructions below to install the plug-in software.

Point/’

@® When installing the plug-in software, check that the product is in the "Advanced Device Development" mode.

% Advanced Device Development - - CW Workbench

File Edit Source BRefactor Mavigate Search  Project Targ

If "Basic Device Development" is displayed on the title bar, change it to "Advanced Device Development" by one of the
following methods:

» Select from the menu bar [Window]=> [Open Perspective] => [Advanced Device Development].
» From the menu that appears by clicking the Open Perspective icon ( ﬁ ) at the upper right corner, select
[Advanced Device Development].

@ The plug-in software install method explained in this chapter is the same as the general install method of Eclipse3.5. To
install the plug-in software, follow instructions provided by plug-in software manufactures.

@ For details on how to use the plug-in software installed, contact the plug-in software manufacturer.

@ |If the installed plug-in software does not properly operate, check if the software can be operated in Eclipse3.5 on public
operating environment provided by the plug-in software manufacturer.
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1. To install the plug-in software, click the menu bar
[Help] => [Install New Software...].

Help

Wielcome

{7) Help Gontents
f%"‘ Search
Dwvnamic Help

key fz=ist. Citrl+Shift+L
Tip= and Tricks...
iCheat Sheets... A

Check for Updates

2. click the button on the Instal

Awvailable Software window.
Select 3 site o enter the location of a site @

Winrk with: [tvpe or select a site vl [ Add. 1

Find more software by working with the 'fivailable Software Sites' preferences.

|type filter text |

Natne: Wersion
[]@ There iz no site selected.

Dietails

[¥] Show only the latest versions of available software [ ] Hide items that are already installed
[¥] Group items by category ‘What is already installed?

[#] Gontact all update sites during install to find required softwars

uone|lelsu| || xipuaddy

21emyos ul-Bnjg ayj Jo uonejelsuiun pue uone|eisu| | xipuaddy

@ < Back HMext > Finizh

« 3. Enter information for the Name and Location fields.
|
= Click the ak. button. A web site where the

plug-in is software installed is added.

Name: || |[ Local.. l

Location: |htt|3:1-"fr |[ frchive.. ]

® o ol ]

An Archive file downloaded from the web site can be also selected for the "Location" field by clicking the

[frehie_Joutton

<

To the next page
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(I T 4 72c\20e (e an be instalod from the aded

Available Software

Select a zite or enter the location of a site.

.

Work with: |type or select a site v‘ [oAdd.

Find more sottware by working with the 'fvailable Software Sites' preferences.

|typE filter text

Name “Wersion
[] Pendire.

Detailz

[#]Show only the latest versions of availsble software [ ] Hide iteme that are already installed
[¥] Group items by cateeory What iz already installed?

[¥]Contact all update gites during install to find required software

@ < Biack

Hext > FEinish

Cancel

<~

Location is acquired.
"Pending..." is displayed as shown on the window
to the left while the information is being acquired.

5. Wihen he package thatcan be installd s e

Available Software
Select a site or enter the location of a site.

e

Work with: |type or select a site v‘ [ Add. |

Find mare software by working with the 'fvailable Software Sites' preferences.

|type filter text

Name Wergion
[1000 Babel Languags Packs in Halian

bel Lal C Ja
Babel Language Packs in Klingon
[]000 Babel Language Packs in Korean

Detailz

Shnw only the latest versions of availsble software Dﬂ\da items that are already installed
[] Group items by cateeory What iz already installed?

Qnma:t all update sites during install to find required software

@ < Back

Mext > Einish

Gancel

<~

Completed
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APPENDIX

Appendix 1.2 Uninstallation

Follow the instructions below to uninstall the plug-in software.

Select the menu bar [Help] => [About CW

1.
‘ GHﬁH.H@H-H ‘H.H @ ‘ Workbench Features].

Click the button.

@ Ihztallation Details

<

Open the <<Installed Software>> tab and select the

% About CW Workbench Features

packages to be deleted.

Click the button to uninstall the plug-in

software.

g+ Babel Language Pack for modeling.mz

E— -

< | b

Update... ][ Uningtall... ] Properties

A5

Completed

uone(elsuIun ¢} Xipuaddy

21emyos ul-Bnjg ayj Jo uonejelsuiun pue uone|eisu| | xipuaddy
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Appendix 2 License Errors

This section explains license errors that may occur when CW Workbench is started and being used.

Appendix 2.1 License errors

112

CW Workbench operates as below when a license error occurs at start-up and during use.

(1) Click the |

* The license is repeatedly checked.

| button on the License Not Found dialog box.

(2) Click the Cancel | button on the "License Not Found" dialog box.

» The license check ends and CW Workbench continues to operate.

If the Cancel button is clicked with license errors occurred and CW Workbench continues to

operate, CW Workbench operates with the following functions disabled:

Functions that cannot be used Functions that can be used
when a license error occurs even when a license error occurs
* Project creation « Editor function (such as new creation, editing, saving, and
* Building searching)
« Target server connection * Importing
* Downloading » Exporting
» Debugging




Appendix 2.2 License error message

APPENDIX

When a license error occurs, an error message "License Not Found" shown below appears. Check error details based

on an error number.

%W License Hot Found

Launchine the Wind River Debue Server (DFWY Backend failed to obtain the
licenze: Overall Licenze for the Wind River Warkbench

v

Ciantiot find licenze file

v

The licenze tiles for server netwark, addreszes) attempted are
lizted below. Uze LM _LIZEMSE FILE to uze a different licenze file,
ot contact your software provider for a license file.

v

Feature: WRE_WDOREBEMCH

Filename: o |icenze¥ RS License. lic

Lizenze path: CAEWRECWANE icenze,C¥WRECWAN 2¥|icenee T30 P _B¥licenze;
Ci¥ME LS ECHEC W icense GO P license G ind River#license; CEWind River -
¥licenze¥zmrzlicenze lic ¥ licenze¥WRSL icenze lic

v

FLEXIm error: =1,388.] Swastem Errar: 2 " Mo such filz or directory”

A

Far further intarmaton, reter to the FLEXIm End Uzer Manual,
available at “wwww macrovisioncom”

i Betry |[ Cancel

5)

No.

Item Description

1)

Error text Displays an error outline within 80 characters.

2)

Error details”! Displays error details and solutions/measures within 3 to 5 lines.

3)

Support information” Information such as a license file name and path information

4)

* FLEXIm error: O, A

) ) O : Error number (-1 to negative number)
FLEXIm error information

A : Minor number (1 to positive number)
In the error message above (FLEXIm error: -1,359)
Error number: -1
Minor number: 359

Displays the error number and minor number of a license error case.(A number used
when an FLEXIm vendor provides support. This guidebook omits explanations.)

5)

System error information™ |
license error.

Indicates the latest error number and error text of the operating system acquired before a

*1

These items are not displayed for the specific errors.
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Appendix 2.3 Main license error messages and recovery
procedures

This section explains license errors that may occur during operations of CW Workbench and how to recover from
errors.

(1) Trial period expiration

If CW Workbench is used with a temporary license, the following license error message appears after 31 days
since installation.

% License HNot Found ﬁ

Launchine the Wind River Debug Server (DFW) Backend failed to obtain the
licenze: Ohverall Licenze for the Wind River Workbench

Feature haz expired

Feature: R WOREBEMCH

Expire date:  31-maw-2010

License path: CEWRECWME|icense¥amrz Licenze lic,C¥WRECYM =¥ icenze;
CR¥WAOP_B¥license G ME LSECEC WIS | icenese GO PElicense G¥Wind River —
¥licenze;¥Wind River¥licenze¥znrzLicenze. lic,o¥¥ license¥WRS Licenze.lic

FLE¥Im errar: —10,32

For further information, refer to the FLEXIm End User Manual,

availsble at v macrovisioncom”

| Betry |[ Cance!

(a) How to recover from the error

Acquire a permanent license and overwrite the file to use CW Workbench.
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(2) Use of an illegal license

If there is an error in host information to be registered when a permanent license is acquired, the following license
error message appears.

Point/’

When "DISK" is selected and a DISK serial number other than the one on the C drive is specified on the Permanent License
Application Form, the same error occurs.

Enter a DISK serial number on the C drive for the Host ID.

When there are multiple drives on the development environment (personal computer) in use, do not enter a DISK serial
number other than the one on the C drive for the Host ID.

% License HNot Found

Launchine the Wind River Debug Server (DFW) Backend failed to obtain the
licenze: Ohverall Licenze for the Wind River Workbench

Irvalid hozt

The hoztid of this svstem does not match the hosztid

zpecified in the licenze file

Feature: WE_WDOREBEMCH

Hostid: Q000000000 2k

Lizenze path: C¥WindRiver#licenze¥WRSLicenze lic,C¥WRECWMY 2% license;
CAEWRECWANE | icenzeC¥WOP B license; CEME LSECRC WY icenze Cr¥ntOP -
¥licenze ¥ nind River¥licenze¥awrzLicense lic o ¥ licenze¥WRS Licenze. lic

FLEXIm errar: -957

For further information, refer ta the FLEXIm End User Manual,

available at “wwww macrovisioncom”

i Betry |[ Cance!

(a) How to recover from the error
Recheck the Host ID of the personal computer where CW Workbench is being used.
« If the Host ID is wrong:
Apply for license transfer using License Transfer Certification Agreement Form in
PermanentLicenseApplicationForm.xls stored in the DVD-ROM. The Host ID to enter here is as follows:
Enter the wrong Host ID registered last time for "Previous License".
Enter a new Host ID to be registered this time for "New License".
+ If the Host ID is correct:
Contact your local Mitsubishi service center or representative.
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(3) Use of a file without license

When CW Workbench has been installed using an install key, the following dialog box appears at the startup of
CW Workbench.

Click the  Cancel | button to start CW Workbench. After the startup, the following license error message
appears.
+ Dialog box

FLEXIm License Finder

“Y'our application was not able to obtain a licenze
because the FLEXIm license manager could nat
determine where ta find the licensing data it
needs. Pleaze choose one of the fallowing:

(%) Specify the License Server
() Specify the License File

Copyright [=] 1993, 2003 Macrovizion Corporation

* License error message

% License Hot Found

Wiarkbench build failed to obtain the license: Overall Licenze for the Wind
River Wiorkbench

Invalid licenze file syntax

Feature: W WIRKEBEMZH

Licenze path: CWindr ver¥license¥awrs License lic, GO PE | icense,;
¥ icenze¥ RS License. lic

FLE*lm error: —2413. System Error 2 77

For further information, refer to the FLEXIm End User Manual,

available at “wenw macrovisioncom” .

| Betry |[ Cancel

(a) How to recover from the error

Apply for a permanent license. After acquiring a permanent license file, apply it to the development
environment (personal computer).
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Appendix 3 comparison with Wind River Workbench

The following table shows the comparison between this product (SW1DND-CWWLQ12-E, SW1DND-CWWLQ24-E)
and Wind River Workbench.

Appendix 3.1 comparison with SW1DND-CWWLQ12-E

O: Applicable, X: Not applicable

CW Workbench Wind River
Item (SW1DND- Workbench
CWWLQ12-E) 2.6.1
Microsoft. Windows" 7 Professional Operating System
Microsoft. Windows' 7 Enterprise Operating System
Microsoﬂ® Windows®7 Ultimate Operating System
@) X
Operating system Microsoft. Windows Vista® Business Operating System
Microsoft” Windows Vista® Ultimate Operating System
Microsoﬂ® Windows Vista® Enterprise Operating System
Microsoft. Windows~ XP Professional Operating System Service Pack3 or later ) @)
Framework Eclipse (Workbench basic function) Ver.3.5 Ver.3.2
SH7750gnule (Compiler for C Controller module (GCC for SH-4A Little Endian o o
compiler)
Compiler
SIMNTgnu (Compiler for VxSim) (GCC for VxWorks Simulator Windows % o
compiler))

Project system and
build system (Project
creation and
management)

VxWorks Downloadable Kernel Module Project (A project used for normal
application development. Applications which are executed in the kernel mode of O @]
VxWorks 6.x are created)

Wind River VxWorks Simulator (A simulation function to execute debugging by
Debugger running the Wind River VxWorks application on the operating system without X O
the actual devices)

MemScope (Specify memory leaks by monitoring the memory usage.)

ProfileScope (Analyze bottleneck of tasks by conducting statistical analysis on
coding status.)

Runtime analysis tool | StethoScope (Analyze memory leaks by monitoring variables and data x o
structures in real time.)

System Viewer (Analyze deadlock and task execution order by monitoring
interrupt task status, CPU utilization, etc.)

J-ZLOTMMO-ANALMS Yim uosuedwo) |'¢ xipuaddy
YOUSQNIONN JBATY PUIM YluMm uosiedwo) € xipuaddy
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Appendix 3.2 comparison with SW1DND-CWWLQ24-E

O: Applicable, X: Not applicable

CW Workbench 5 .
Wind River
Item (SW1DND-
Workbench 3.2
CWWLQ24-E)
Microsoft. Windows" 7 Professional Operating System
Microsoft” Windows" 7 Enterprise Operating System
Microsoft. Windows" 7 Ultimate Operating System
Operating system Microsoft” Windows Vista® Business Operating System O O
Microsoﬂ® Windows Vista® Ultimate Operating System
Microsoft. Windows Vista" Enterprise Operating System
Microsoft” Windows® XP Professional Operating System Service Pack3 or later
Framework Eclipse (Workbench basic function) Ver.3.5 Ver.3.5
PENTIUM4gnu (Compiler for C Controller module (GCC for Intel Atom Z5xx ) o
compiler))
Compiler
SIMNTgnu (Compiler for VxSim (GCC for VxWorks Simulator Windows « o
compiler))
Wind River VxWorks Simulator (A simulation function to execute debugging by
running the Wind River VxWorks application on the operating system without X O
the actual devices)
Debugger
Dynamic Printf (A function to dynamically insert or cancel the printf statement
when debugging the program without embedding the printf function to the O O
source code with the similar operation as that of the breakpoint)
MemScope (Specify memory leaks by monitoring the memory usage.)
ProfileScope (Analyze bottleneck of tasks by conducting statistical analysis on
coding status.)
Runtime analysis tool X O

StethoScope (Analyze memory leaks by monitoring variables and data
structures in real time.)

System Viewer (Analyze deadlock and task execution order by monitoring
interrupt task status, CPU utilization, etc.)
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Appendix 4 support

APPENDIX

Appendix 4.1

Controller module

Technical support assistance service regarding C

For technical support assistance service regarding C Controller module, refer to the table below.

If you are not sure which type the inquiry belongs to, please contact us. Please note that inquiries other than MELSEC-

related inquiries may not be able to be answered.

Type Inquiry Where to contact
» Functions and specifications of C Controller module
+ Specifications and usage of the dedicated function library
provided by Mitsubishi Electric Corporation 5 i q .
MELSEC- « C controller setting and monitoring tool, and functions and ~ Information and services
related specifications of CW Workbench For further ir.1fo!'mation and .services, please consult your
- Functions and specifications of the Mitsubishi products to | local Mitsubishi representative
be used with C Controller module (such as units and
MELSOFT)
» Functions and specifications of VxWorks, API functions
Operating provided by VxWorks, and general inquiries regarding ) .
; Wind River Systems, Inc.
system- programming related to VxWorks L
. L . . URL: http://www.windriver.com
related » Functions and specifications of Wind River Workbench and
Tornado
Plug-in . . . .
* Inquiries regarding the plug-in software to be used with CW )
software- ) ] Plug-in software manufacturer
related Workbench or Wind River Workbench
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F the installation location. . .. . ................ 29
TROUBLESHOOTING . . ................... 96
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U
H
Uninstallation . .......................... 39
Howto ApplyPatch . ...................... 53 Updated license product. . . ................. 15
How to Build Project. . . .. .................. 69 URL . ... 12
Howto ObtainPatch ...................... 53
\")
|
"Variables" window "Registers" window "Expressions"
Installkeyfile. . .. ... ... ... ... ... . .. 18 window "Memory Browser" window . . .. ........ 55
Installation. . . . ...... ... ... ... ... .. ..... 27 VXWOrKS. . oo 11
Installation at X YYYY . .................. 38,51 VxWorks 6.4.1 Application Developer .......... 38
Installation using a permanent license . ......... 20 VxWorks 6.8.1 Application Developer . ....... 38,51
Installation using a temporary license. . ......... 20 VXWorks COMX. . . . ..o vi i 38,51
Installation using an install key in the DVD-ROM . . . 20 VxWorks Development Shell. .. ............ 38,51
L w
LAC . .. 32 Wind River Registry for Workbench 3.2 . ... 38,41,51
License Errors . . . . oo 112 Wind River Systems, Inc ................... 1
License Transfer .. ....................... 23 Wind River Workbench 3.2. . ................ 13
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